CESKA ZEMEDELSKA UNIVERZITA V PRAZE

FAKULTA ZIVOTNIiHO PROSTREDI

KATEDRA VODNIHO HOSPODARSTVI A ENVIRONMENTALNIHO
MODELOVANI

VYUZITI HYDRAULICKEHO MODELU PRO GENEROVANI RASTRU
HLOUBEK V ZAPLAVOVEM UZEMI

BAKALARSKA PRACE

Vedouci prace: Ing. Radek Roub Ph.D.

Bakalant: Lukas Toman

2011/2012



zadani



Lukas Toman Prohlaseni

Prohlaseni:

ProhlaSuji, Zze jsem tuto diplomovou praci vypracoval samostatné¢ pod
vedenim Ing. Radka Rouba Ph.D. a Ze jsem uvedl vSechny literarni prameny, ze

kterych jsem Cerpal.

V Praze dne 26. 4. 2012

Lukas Toman



Lukas Toman Podekovani

Podékovani:

Zde bych chtél podeékovat svému vedoucimu bakaldiské prace panu Ing.
Radku Roubovi Ph. D. za veskeré rady, které mi pomohli tuto praci vytvofit. Také
bych chtél pode€kovat statnimu podniku PVL, ktery mi poskytl potiebnd data
K realizaci této prace a v neposledni fad¢ bych chtél podeékovat celé rodiné za

dlouhodobou a vsestrannou podporu pii mém studiu.

V Praze dne 26. 4. 2012

Lukas Toman



Lukas Toman Abstrakt

ABSTRAKT

Tato prace se zabyva problematikou stanoveni zaplavovych Car a vytvoienim
rastru hloubek v inunda¢nim uzemi pro povodnové udalosti s dobou opakovani 20,
50 a 100 let. K témto cilim byly pouzity softwary ESRI ArcGIS Desktop 9.3 a HEC-
RAS 4.1.0. ArcGIS byl pouzit pro tvorbu digitalniho modelu terénu (DMT), ptipravu
geometrickych dat k vypo¢tu hydrodynamického modelu a konecnou vizualizaci
vytvofenych map. Software HEC-RAS byl pouzit pro samotny vypocet 1D
hydrodynamického modelu. Jako zajmové uzemi pro tuto praci bylo vybrano uzemi

ve stfedni ¢asti povodi toku Klabava, které se nachdzi na zapade Cech.

Kli¢ova slova

zaplavové uzemi, povoden, povodi, GIS, HEC-RAS, vodni tok, N-lety prutok,
hydrodynamicky model

ABSTRACT

This work is aimed on flood lines determination and depth-grid creation in
the inundation areas for flood events with return period of 20, 50, and 100 years.
Two software programmes were used: ESRI ArcGIS Desktop 9.3 and HEC-RAS
4.1.0. Software ArcGIS was used for digital terrain model (DTM) creation,
geometric data pre-processing needed for hydro dynamical model, and for final
visualisation of resulting maps. HEC-RAS software was used for 1D hydrodynamical
model calculation. The case study was performed in the middle part of the river basin

Klabava located in western Bohemia.

Klicova slova

inundation area, flood, basin, GIS, HEC-RAS, watercourse, N-years discharge,
hydrodynamic model
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1. UvOD

4

tyCe ohrozenosti obyvatel a majetku. Je to dano i tim, Ze se u nas neobjevuji nicivé
zem¢étieseni €i jiné piirodni extrémy. | proto maji zaznamy o povodnich na nasem
uzemi pomérné staré koteny, které sahaji az k pocatkim novoveku tedy ke startu
d¢jinné epochy, ktera je nejcastéji prisuzovana k roku 1492, kdy Krystof Kolumbus
objevil Ameriku. Piikladem jsou tieba Staré letopisy Ceské ze srpna roku 1501, které
mluvi o velké povodni v Praze na Vltave. Dal§im prikladem je zdznam o povodni na
Moravé z kvétna roku 1715, kde byly rozboufenou fekou Bec¢vou strzeny tfi mostni
pilite v Prerové. Takto bychom mohli vyétem povodni na nasem tizemi pokracovat,
avsak jsou to pouze zdznamy z historickych spisi ¢i jinych paméti. Dilezitym
obdobim pro pozorovani vyskytu povodni je pocatek 20. stoleti, kdy se zacala
rozvijet stani¢ni pozorovaci sit’ vodnich tokti. Diky tomuto mohly byt povodné
sledovany nejen z hlediska zptisobenych $kod a vysky hladiny, ale také z hlediska

kulminac¢nich pratokil a objemu povodiiové viny.

Jak jiz bylo feceno, problematika vyskytu povodni mé na naSem Uzemi
dlouhou historii, pfesto se v posledni dob¢ stava ¢im dal tim aktuéln&jSim tématem
nejen pro vodohospodare, ale i pro Sirokou vefejnost. Bezpochyby za timto trendem
stoji série extrémnich povodni poslednich let, které se vyskytli na uzemi Cech
a Moravy v letech 1997, 1998, 2002, 2006 a 2009. Jako prvni takzvanou extrémni
povodni za poslednich 15 let je vnimana povoden z ¢ervence roku 1997, kdy zasahla
vychodni Cechy, ale hlavné Moravu. Ta byla zatopena z celé jedné tietiny, zahynulo
501idi a materialni $kody byly vyc¢isleny na vice nez 63 miliard korun, coz byla do té
doby viibec nejvétsi Skoda zpiisobend povodnémi na nasem uzemi. Povoden, ktera
postihla vychodni Cechy v roce 1998, takové §kody na majetku zdaleka nenapachala.
Ty byly vycisleny na 2 miliardy korun, ale i piesto bylo poni¢eno ptes 30 vesnic
azahynulo 6 lidi. To povodent v 1ét& 2002, ktera postihla zejména uzemi Cech
v povodi Vltavy a dolniho Labe, byla vibec nejni¢ivéjsi povodni novodobé historie
Ceské republiky. Poskozeno bylo pies 800 obci. Nejvétsi skody byly zaznamenany
Vv hlavnim mésté v Praze, kde byl kulminaéni prutok stanoven jako 500-lety,
zaplaveno bylo prazské metro a ohrozeno bylo i historické centrum, to ochranily az
narychlo postavené protipovodiiové stény. Skoda na majetku piekrodila

I astronomickou hodnotu z roku 1997, byla vyc¢islena na 73 miliard korun a celkem
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zahynulo 17 lidi. V bfeznu a dubnu roku 2006 vznikly povodné v disledku tani
vysoké sn¢hové pokryvky a hustého dest¢ a byla zasazena téméf celd republika.
Zatim posledni ze série extrémnich povodni probéhla v 1ét¢ 2009 na Jesenicku
a Novojic¢insku, znama jako bleskova povoden. Vznikla v dusledku vyskytu velkého
mnozstvi ptivalovych destd a boufek na pomérné malém uzemi, nejvice Skod bylo

zpusobeno na infrastruktute, bylo evakuovano vice jak 1400 osob a 13 lidi zemfelo.

Z vyse uvedenych divoda je kladen vyznam na vznik protipovodinovych
opatfeni, kterda maji snizit Skodlivé ulinky povodni. Ochrana pied povodnémi je
vnimadna jako soubor opatfeni zamezujici a predchazejici nicivym vlastnostem
povodné jako je ochrana zivoti, zdravi a majetku obyvatel, spole¢nosti a Zivotniho

prostiedi.

Jednim z téchto opatfeni miize byt matematické modelovéani, které mize
pomoci predvidat vyskyt, objem a priibéh povodinové viny a tim i zdokonalit krizové
feSeni pii vyskytu konkrétni povodné. Dal$im vyuzitim matematického modelovani
muze byt 1 stanoveni ziplavového Uzemi, neboli inunda¢niho Gzemi pii rizné
velikosti kulmina¢niho pritoku coz ve spravné spolupraci s izemnim planovanim

muze snizit zpasobené Skody na majetku fyzickych ¢i pravnickych osob.

Jinym typem opatienim muize byt zvySeni akumulace a retence vody
Vv povodi, toho lze docilit zejména Spravnym vyuzivanim pidy v povodi. Piikladem
tohoto typu ochrany je nenavysSovat rozlohu zastavénych ploch v uzemi a tim docilit
snizeni povrchového odtoku a snizeni pravdépodobnosti vyskytu povodné, zejména
pak té ,,bleskové®. Nejvhodnéjs$im krajinnym pokryvem v povodi je les, ktery nejvice
transformuje intenzivni srdzky Vv disledku velké ptirozené retence. Do tohoto typu
opatfeni spadd i vymezeni vhodného inunda¢niho izemi podél toku, tzv. suché
poldry, které akumuluji vodu vylitou ze biehd toktli, zde se vSak nardzi na problém
vykupovani pozemki od velkého mnoZstvi vlastnikil. Jako posledni opatieni tohoto

typu by se mohla zatadit vystavba vodnich dél s retencni funkci.

Poslednim typem protipovodiiovych opatfeni jsou technicka opatfeni, do
nichz spadaji zejména protipovodiiové zdi a jiné protipovodiiové bariéry. Tyto
opatfeni by vSak méla byt vytvofena jen v krajnim ptipad€, protoze zvétSeni
prato¢ného profilu toku, sice prevede vetsi mnozstvi vody, ale mize odsunout

stavajici problém ve formé velkého pratoku nize po toku a ohrozit jind Gzemi.

10
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2. CILE A METODIKA

2.1 Cile
- Vytvoreni digitalniho modelu terénu (DMT) feSeného uzemi
- Stanoveni hydrologickych charakteristik na useku mezi 25,86 a 35,90
ficnim kilometrem vodniho toku Klabava
- Vymezeni zaplavovych car v feSeném tzemi pro povodné s dobou
opakovani 20, 50 a 100let.
- Vygenerovani rastru hloubek v inunda¢nim Uzemi feSené oblasti pro
scénaie povodnovych viny o velikosti kulminac¢nich pratoktt Qzo, Qsp,
Q1o0.
2.2 Metodika

Prvnim a zasadnim krokem pro Gspé$né zpracovani této bakalaiské prace je
nastudovani odborné literatury a odbornych c¢lankli publikovanych v odbornych

casopisech a sbornicich, které se vztahuji k dané problematice.

DalSim krokem je zajisténi potiebného softwaru pro zpracovani jednotlivych
Casti bakalarské prace.

Tfetim bodem pro vytvoteni této bakalafské prace je stanoveni piirodnich
charakteristik konkrétniho povodi a sbér potifebnych dat. Zakladni data mi poskytlo
Povodi Vltavy (PVL) a to ve formé bodového pole vyskopisnych bodi ziskanych
podle informace PVL metodou leteckého laserového skenovani (LLS) a pti¢nych
profill, oboji v grafické podob& ve formatu dgn a textovém dokumentu ve formatu
txt. Dale mi byl poskytnut podélny profil toku ve formatu dgn a veskeré objekty na
toku i s fotodokumentaci jednotlivych objektt. Dalsim poskytnutym podkladem byla
ficni mapa a mapa z katastru nemovitosti v méfitku 1:2000, oboji ve formatu dgn
a dxg. A jako posledni data mi povodi Vltavy poskytnulo rastrové mapy v méfitku
1:50000 a 1:10000. Veskera data z Povodi Vltavy bylo nutno roztfidit na data, se
kterymi budu dale pracovat a ktera nevyuziji. Déle jsem pouzil data DIBAVODu,
ktera jsem stahl ve formatu shp napt. datovy soubor vodnich tokt, hydrologického

Clenéni povodi III. a IV. fadu. Jako hydrologicka data jsem pouzil N-leta data

11



Lukas Toman Cile a metodika

z hlasného profilu Hradek u Rokycan a operativniho profilu StraSice spravovanymi
CHMU.

Po sbéru a roztiidéni dat pfisla na fadu rekognoskace terénu. Cilem bylo
vytvofit fotodokumentaci feSeného tuzemi, stanovit drsnostni soucinitel potiebny pro
vstup do matematického modelu a v neposledni fad¢ jsem proved| vizualni porovnani
pfipravenych dat a zjisténych piirodnich charakteristik S realitou na vodnim toku

a jeho povodi.

Poslednim krokem je sestrojeni hydrologicky korektniho DMT, vytvoteni
matematického modelu potiebného k vygenerovani rastru hloubek v zaplavovém
uzemi, samotné vygenerovani rastru hloubek v zadplavovém tzemi a nasledna analyza
a vizualizace vyslednych vystupti na vhodném mapovém podkladé, to vSe za pomoci

dostupného kvalitniho softwaru ur€eného k feSeni dané problematiky.

12
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3. MATEMATICKE MODELY HYDROLOGICKYCH CYKLU

Cilem matematického modelovani hydrologickych procest je znazornéni
Casové a prostorové zavislosti urcitych veli¢in, charakterizujici hydrologicky rezim

povodi nebo jeho ¢asti (KOVAR 1990).

Hydrodynamické modelovani ma velikou piednost zejména v prevenci
zmirnéni povodnovych Skod v zaplavovém tuzemi, zejména ve fazi planovani
protipovodnovych opatienich a to z toho divodu, ze diky matematickym modeliim
jsme schopni piedpovidat prib&hy a velikosti povodiiovych udalosti i u scénaiti
s delsi dobou opakovani, jako jsou napt. 100-leté, 500-let¢ a vétsi povodnové

udalosti, které se z hlediska historie na daném uzemi jesté neobjevili (CHEN 2007).

K mapovani povodiiovych rizik a k jejich ptfedvidani slouzi hydrodynamické
modely, zvlast¢ pak 1D a 2D modely. Ty piedstavuji realnou piedstavu
0 vlastnostech povodné¢ (COBBY a kol. 2001).

Ke vhodnému zvoleni matematického modelu pro vytyc€eni inundaéniho
uzemi je zapotfebi znat predevSim pouzité prostorové schematizace, spolecné
s matematickou formulaci teoretického zakladu. V soucasné dobé se pouZivaji
modely jednorozmémé (1D), kvazi-dvourozmérné (1,5D) a dvourozmérné (2D)
(DRBAL a kol. 2009).

3.1 Jednorozmérné (1D) matematické modely

Vyhodou jednorozmérnych modela jsou jejich malé naroky na vstupni data.
Vstupni data jsou redukovana na pozadavek kvalitni schematizace fi¢ni sit€ ve
sledované oblasti, jenz je doplnéna piicnymi profily, které jde zjednodusené
charakterizovat v kazdém profilu pomoci polohy hladiny (hloubky vody v koryt¢)
a stfedni prifezové rychlosti ve sméru osy koryta. V tomto modelu je pfedpokladana
orientace proudéni ve sméru spojnic mezi jednotlivymi pficnymi profily. Dal§Simi
vyhodami tohoto modelu je jeho relativni jednoduchost, snadné kontrola a prezentace
vystupt. Tento model lze pouzit zejména, pokud se v feSeném Uzemi vyskytuje
pfevazné proudéni s jednorozmérnym charakterem (HORRITT, BATES 2002,
DRBAL a kol. 2009).

13
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Ze stru¢ného popisu modelu plyne, ze tyto modely maji omezené pouziti
Vv souvislé méstské zastavbeé, kde ve sméru toku stoji piekazky, jako jsou stavby,
oploceni atd. Avsak MARK a kol. (2004) tvrdi, Ze 1D hydrodynamické modely by

mohli byt pouzity k simulaci zaplavy v méstské zastavbe.

Problematikou vyuzivani jednorozmérnych hydraulickych modeli se v dneSni
dob& zabyva mnoho autord. Z &eskych jsou to napiiklad KULHAVY, KOVAR
(2002), DANHELKA a kol. (2002) a jini. Daleko v&t§im rozvojem prochézi tato
problematika, ve svété kde mezi nejznaméjsi autory patii BEVEN (2001),
REFSGAARD, STORM (1996), SMITH a kol. (2004), a spousta dal$ich.

3.2 Kvazi-dvourozmérné (1,5D) matematické modely

Pouziti 1,5D modeli umoznuje vyuzit relativné jednodus$si principy
jednorozmérného modelovani pied principy slozit€jsiho  dvourozmérného
modelovanim 1 v geometricky slozitéj$im inunda¢nim tzemi. Pfi tvorbé tohoto
modelu se Gzemi schematizuje vétvenou ¢i okruhovou siti. Tento postup je vhodny
pro feSeni proudeéni v piehlednych podminkach proudéni, tedy jen tehdy kdy je
mozné predem s jistotou urcit hlavni sméry proudéni. Musi byt pfesné znama mista
natokt, vytoki z deStovych kanaliza¢nich siti a jinych objektu, které mohou ovlivnit
sméry proudéni vtoku nebo inundaénim tzemi. Pokud neni mozZzno proudéni
v nékterych ¢astech zajmového izemi predem jednoznacné urcit, nemél by byt tento

typ modelu pouZzit (DRBAL a kol. 2009).

3.3 Dvourozmérné (2D) matematické modely

vvvvvv

podminkach inunda¢niho uzemi, tedy v piipadech kdy nestaci popis tzemi v podobé
izolovanych piicnych profili. V této metodé¢ se vyuziva prostorového zobrazeni
koryta toku a inunda¢niho uzemi pomoci DMT, ktery detailn€¢ vystihuje
geometrickou Clenitost feSeného tzemi. Tyto modely jsou tedy vhodné pro Siroka
inundacni izemi s nepravidelnymi terénnimi prvky a vSude tam kde nejde pouzit 1D
¢i 1,5D hydrodynamické modely. Dvourozmérné modely maji tedy vétsi naroky na
vstupni data 1 na zpracovani vlastnich simulaci, maji vSak podrobnéjsi vystupy

(HORRITT, BATES 2002, DRBAL a kol. 2009).
14
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4. SOFTWARE POUZiVANY PRO 1D HYDROLOGICKE MODELOVANI

V souCasné dobé se v zavislosti s rozvojem vypocetni techniky velmi
dynamicky rozvijeji i hydrologické modely a moznosti jejich vyuziti. Pro kvalitni
simulaci feSené¢ho jevu potiebuji modely velké mnozstvi kvalitnich dat. Proto
modely, které jsou kompatibilni s GIS, kde 1ze provést napt. i naslednou vizualizaci
vyslednych hodnot z hydrologickych modelti, jsou v souc¢asné dobé nejvhodnéjsi
k feseni této problematiky (JENICEK, NEMECKOVA 2007).

4.1 HEC-RAS

HEC-RAS ( Hydrologic Engineering Centers River Analysis System) je
hydrologicky model vyvinuty armadou Spojenych stati americkych. Tento model
slouzi pro hydrologické modelovani proudéni vody v koryté toku a v ptilehlém
inunda¢nim uzemi. Timto softwarem lze modelovat pohyb vody v koryté
a inundacnim tGzemi za ustdleného i neustdleného stavu proudéni. Do vypoctu
modelu mizeme zahrnout i rizné objekty na toku jako jsou jezy ¢i mosty, které je
mozno velmi vystizné charakterizovat napt. podle velikosti, tvaru a umisténi pilift
mostu vzhledem k prato¢nému profilu toku. Velikou vyhodou tohoto modelu je
vznik extenze HEC-GeoRAS, kterou lze vyuzit k exportovani a importovani dat
z GIS a tim zvySeni vyuziti tohoto modelu. Vystupy z HEC-RASu jsou tabulkové,
ale 1 ve formé 2D ¢i 3D grafi. HEC-RAS je program hojné pouZivany po celém
svété i v Ceské republice a ma za sebou dlouhou dobu vyvoje, coZ zaruéuje velkou
uzivatelskou podporu tohoto softwaru (MAIDMENT, DJOKIC 2000; HEC-RAS
2010)

4.2 HYDROCHECK

Tento program na hydrologické modelovéani byl vytvotren ¢eskou spolecnosti
Hydrosoft Veleslavin s.r.o. ve spolupraci s povodim Ohie a.s.. Program slouzi
k modelovani jak rovnomérného, tak i nerovnomérného ustaleného proudéni. Diive
program pracoval v opera¢nim systému MS-DOS, v roce 2006 vsak byl software
vytvofen i pro uzivatele operacniho systému Windows. Novy HYDROCHECK vsak
nebyl pouze piepracovan, aby pracoval v operacnim systému Windows, byl

kompletné predélan po strance numerické i po strance uzivatelské. Vyhodou tohoto
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programu je opét slucitelnost s formaty GIS, dale pak i1 zapracovani desitek
uzivatelskych pozadavkil vcetné novych legislativnich zmén, které probéhly na
naSem uUzemi jako je napf. posuzovani aktivnich zaplavovych zén (HYDROSOFT

VELESLAVIN S.R.0. 2009).

4.3 MIKE-SHE, MIKE 11

MIKE-SHE a MIKE 11 jsou jednorozmérné matematické modely vytvoiené
danskou spolecnosti DHI (Danish Hydraulic Institute), které se zabyvaji pohybem
vody v otevienych korytech a v inunda¢nim tzemi. Proto se tyto modely vyuzivaji
v modelovani povodnovych udalosti. I zde je vyhodou programu jeho komptabilita
s GIS. Danska firma DHI vystupuje na trhu od roku 1990, proto lze fici, ze
i hydrologické modely od této firmy jsou jiz tradiénim produktem na trhu pro
hydrology, hydrauliky, vodohospodare a dal$i inzenyry zabyvajicimi se nejriznéjsi
problematikou tykajici se Zivotniho prostiedi. | z tohoto divodu jsou MIKE-SHE
aMIKE 11 velice rozsifenymi a vyuzivanymi softwary po celém svété (online:

www.dhi.cz).
4.4 NASIM

Model NASIM (Niederschlag-Abfluss Simulation Modell) vytvotila némecka
firma Hydrotec Gmbh. Zacéatek vyvoje modelu se datuje k pocatku 80. let 20. stoleti,
kdy byl vyvinut jako nastroj pro hydrology a ekology, aby slouzil k pfedpovédi
aplanovani nejriznéjSich vodohospodaiskych systémt, jako je tfeba piedpoveéd
povodnové udalosti (HYDROTEC Gmbh 2003). Model NASIM také spolupracuje
s GIS, ke kterému bylo vytvoteno i1 n€kolik nadstavbovych extenzi. V soucasné dobé
se tento model pouZiva zejména v Némecku, v Ceské republice zatim pravdépodobné

nebyl pouzit k aplikovanému vyzkumu (JENICEK 2005).
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5. SCHEMATIZACE GEOMETRIE VODNiIiCH TOKU

Jednim z hlavnich vstupnich udaji pro hydrodynamické modely jsou data pro

tvorbu geometrie vodniho toku, zejména pak data vyskopisna (COBBY a kol. 2001).

5.1 VySkopisné podklady

Pro sestaveni hydrodynamickych modell i pro analyzu jejich vysledkl se

dnes pouzivaji téi zpisoby pofizovani téchto dat: (HEJDUK, ROUB 2011)

1. Geodetické zaméfeni
2. Fotogrammetrie

3. Letecké laserové skenovani (LLS)

5.1.1 Geodetické zaméreni:

wev

zpusobim, proto se v dnesni dobé prechdzi k modernéjsSim metodam schematizace
vodnich tokl. Vyhodou geodetického zaméfeni je vSak jeji pfesnost, a proto se
pouziva v kombinaci s jinymi metodami jako doplitkova metoda. Geodetické méfeni
musi dostateCné charakterizovat smér, pficny a podélny profil vodniho toku
a prilehlého inunda¢niho tizemi a také polohu, velikost a tvar objektu na vodnim
toku. VSechen geodeticky materidl musi byt v polohopisném systému S-JTSK
a vyskopisném systému Balt po vyrovnani (Bpv). Samotné geodetické zaméfeni se

pouziva vyhradné pro 1D hydrodynamické modely.
5.1.1.1 Geometrie vodniho toku

Geometrie vodniho toku je charakterizovana podrobnym geodetickym
zamé&fenim polohopisu osy toku, polohopisnym a vySkopisnym zamétenim pii¢nych
profili, které musi vystihovat jakékoliv prostorové zmény v geometrii Koryta.
Vzdalenost pifi¢nych profili se urcuje podle konkrétni situace v terénu, vétSinou se
vSak vzdalenosti pohybuji od nékolika desitek metrii v intravilanu, az stovky metrii

Vv extravilanu u stabilnich koryt s neménnym podélnym a pfi¢nym profilem koryta.

17



Lukas Toman Literdrni reserse

5.1.1.2 Geometrie inunda¢niho 1zemi

Tvorba jednorozmérnych modelti vyzaduje pfi zaméfovani geometrie
inunda¢niho tzemi podobné vlastnosti jako u zamétovani koryta vodniho toku, tj.
vystizn€ zvolené piicné profily, které dostateCné vystihuji tvar inundacniho uzemi.
Z toho divodu ma byt Sitka profili dostatecné dlouhd, aby zasihla celé inundacni
tizemi pro kazdy scénatf kulminaéniho pritoku. Udolni profily maji byt kolmé na

proudnici toku a rovné popiipadé zkosené dle potieby.
5.1.1.3 Geometrie objektl na vodnim toku

Podrobné¢ musi byt zaméfeny vSechny objekty (mosty, lavky, jezy, brody,
splavy) na vodnim toku, které jakymkoliv zptisobem ovliviiuji prichod povodiové
vilny. Ze zaméfeni musi byt jednoznaéné charakterizovany tvar objektu
I S navazujicimi terénnimi souvislostmi (nasypy, vykopavky), dale pak musi byt

jasny tvar a sklon koryta pod a nad objektem véetné souvisejicich konstrukei koryta.

Tato podkapitola ,,5.1.1 geodetické zaméfeni* byla zpracovana kompletné
podle (DRBAL a kol. 2009).

5.1.2 Fotogrammetrie:

Definice  fotogrammetrie zni podle PAVELKY (2003a) takto:
Fotogrammetrie je véda, zplsob a technologie, ktera se zabyva dale vyuzitelnych
metfeni, map, digitdlniho modelu terénu a dalSich produktd, které lze ziskat

Z obrazkového nejcastéji fotografického zdznamu.

Fotogrammetrie prodélala v poslednich letech velky technologicky pokrok
a pfeménu z obdobi analogového a analytického do obdobi digitalniho (HODAC
2007).

Fotogrammetrii lze rozdélit, jak fika PAVELKA (2003a) podle:
1. Polohy stanoviska

- Pozemni

- Letecka

- Druzicova
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2. Poctu a konfigurace vyhodnocenych snimki
- Jednosnimkova fotogrammetrie
- Vicesnimkova fotogrammetrie
3. Technologického zpiisobu zpracovani
- Metody analogové
- Metody analytické
- Metody digitalni
4. Typu vystupu

Grafické

- Numerické

Ptevazna cast fotogrammetrickych cinnosti spadd v dneSni dob& pod
fotogrammetrii leteckou, kde je velka ¢asova hospodarnost pii mapovani i sbéru dat

pro GIS nebo DMT (PAVELKA 2003b).

Leteckd fotogrammetrie se pouZziva pro sbér polohopisnych 1 vySkopisnych
dat ve velkych a stfednich méfitkach a jeji vyhodou je rychlost potfizeni dat a také
znaén€ nizsi finanéni vydaje neZ u geodetického zaméteni. U digitalntho modelu
reliéfu (dale jen DMR) je zakladni vrstva tvofena rastrem 3D boda, kde je optiméalni
velikost mfiZe rastru 15 x 15m, ktery je doplnén vyznamnymi terénnimi hranami
v podob¢ 3D linii. Vyznamnou terénni hranou nebo lomem se rozumi hrana ¢i lom,
jehoz relativni vySka je vétsi jak 25cm. PoZadovand piesnost je dana maximalni

polohovou odchylkou 0,5m a stfedni vyskovou chybou 0,11m (PECH a kol. 2011).

5.1.3 Letecké laserové skenovani (LLS)

LLS patii vdneSni dobé k nejmodernéj§im zplsobiim pro ziskavani
prostorovych geografickych dat. Tato metoda se stale vice povazuje za ekonomicky
a produkéné nejpriznivejsi, to dokazuje 1 vyrazné zvySujici se vyuzivani ve
vyspélych statech Evropy, Kanady a USA. V Ceské republice se predpoklada také
velky rozvoj a vyuZiti této technologie. Svéd¢i o tom projekt, ktery zacal v roce 2009
a jeho konec je naplanovan na rok 2012. V tomto obdobi probéhlo a bude probihat
nové vyskopisné zaméfeni celého uzemi Ceské republiky. Na tomto projektu
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spolupracuje Cesky uiad zeméméficky a katastralni s Ministerstvem zemé&délstvi CR

a Ministerstvem obrany CR (UHLIROVA, ZBORIL 2009).

Po zpracovéni dat vzniknou tyto tfi vysledné produkty v odliSném Casovém

horizontu (BRAZDIL 2009):

1. Digitalni model relié¢fu izemi Ceské republiky 4. generace (DMR
4G), ve tvaru miize (GRID) 5 x 5m s uplnou stfedni chybou vysky

0,3m v odkrytém terénu a 1m v zalesnéném terénu.

2. Digitalni model reliéfu uzemi Ceské republiky 5. generace (DMR
5G), ve tvaru nepravidelné sité¢ vysSkovych bodid (TIN) s tplnou
sttedni chybou vysky 0,18m v odkrytém terénu a 0,3m v zalesnéném

terénu

3. Digitalni model povrchu tzemi Ceské republiky 1. generace (DMP
1G), ve tvaru nepravidelné sit¢ vyskovych bodi (TIN) s uplnou
sttedni chybou vysky 0,4m pro piesné¢ vymezené objekty (budovy)
a 0,7m pro objekty presné neohrani¢ené (lesy a dalsi prvky rostlinného

padniho krytu).

Metoda LLS ma ve vodohospodafistvi velkou perspektivu, naptiklad v odvétvi
hydrologie se pouziva pii mapovani rozvodnic povodi vodnich tokil, pro zptfesnéni
poloh os vodnich tokl a také pro identifikaci pfi¢nych prekdzek v koryté vodniho
toku (ROUB a kol. 2012). Poslednim tématem, tedy identifikaci pficnych prekazek
v koryté se pak zabyvaji autoii UHLIROVA, NOVAKOVA (2011) a to zejména ve
vztahu pticnych prekazek v korytech tokli vii¢i migraci ryb a monitorovani téchto
prekazek, coz je dalSim dikazem univerzalnosti a dualezitosti dat ziskanych z LLS

pro odvétvi vodniho hospodafstvi.

Data jsou ziskdvana pomoci laserovych paprskl, které jsou vysilany ze
specidlniho skeneru, ten je umistén na leteckém zafizeni (letadlo, vrtulnik, model
letadla). Poloha bodu je stanovena prostorovym rajonem, kdy hraje zasadni roli
vzdalenost od skeneru. Vzdalenost je urena pomoci Casu, kdy byl vyslan signal
laserového paprsku k povrchu, kde se odrazi od povrchu, nebo jiného objektu

a nasledné se vrati signal zpét do skeneru (SIMA 2009).

Nejveétsimi vyhodami LLS je velkd hustota naméfenych dat (3D bodi)

v kratkém casovém intervale, tzv. mra¢no bodl. Dalsi bezpochyby velkou vyhodou

20



Lukas Toman Literdrni reserse

je moznost pouziti této metody i za tmy, diky svému vlastnimu zdroji svétla neni
LLS odkédzano na slunecni svétlo a je tedy funkéni 24 hodin denné. V neposledni
fadé je vyhodou i vysoka piesnost naméfenych dat (www.geodis.cz a UHLIROVA,
ZBORIL 2009).

5.2 Mapové podklady

Mapové podklady slouzi piedevs§im k orientaci v zajmovém uzemi, popt. pro
zptesnéni informaci pii stanovovani ohrozenosti zaplavového uzemi. Podle

DRBALA a kol. (2008) 1ze mapové podklady rozdélit na:
1. ZABAGED
2.RZM 10
3. Ortofotomapy
4. Vektorové katastralni mapy

5. Geologické mapy

5.2.1 ZABAGED

Zéakladni baze geografickych dat poskytovatelem je Cesky uiad zeméméticky
a katastralni. ZABAGED je digitalni kartograficky model Ceské republiky na tirovni
podrobnosti zakladni mapy CR 1:10 000 (ZM 10).

Polohopisnd ¢ast ZABAGED obsahuje dvourozmémé (2D) prostorové
informace a popisné informace o geografickych objektech. V soucasné dobé je
databaze tvorena 123 typy geografickych objekti, které spadaji do téchto kategorii
objektl:

- Sidelni, hospodaiské a kulturni objekty
- Komunikace

- Rozvodné sité¢ a produktovody

- Vodstvo

- Uzemni jednotky véetné chranénych uzemi
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- Vegetace a povrch
- Terénni reliéf
- Geodetické body

Vyskopisna ¢ast ZABAGED zahrnuje trojrozmérné (3D) prvky terénniho

reliéfu a je prezentovana souborem 3D vrstevnic.

Obsah ZABAGED je stale rozsitfovan, dle potieb jejich uzivatel.

5.2.2RZM 10

Digitalni rastrova zakladni mapa uzemi CR vméfitku 1:10 000,
poskytovatelem je CUZK. Tato mapa lze vyuZit jako podklad pro vysledky

jednotlivych analyz spojenych s hydrologickym modelovanim.

5.2.3 Ortofotomapy

v

Vétsinou slouzi jako nejaktualnéjsi informace nebo jako podklad pro fesené

uzemi.

5.2.4 Vektorové katastralni mapy

Tyto mapy jsou vyuzitelné hlavné pro detailngjsi vypocet povodnovych Skod

zptisobenych na majetku. Poskytovatelem je CUZK.

5.2.5. Geologické mapy

Tyto mapy jsou nezbytné pro vymezeni tzv. rezidualnich oblasti (to jsou
plochy s velmi malou Cetnosti vyskytu povodné napi. pro scénaie Qsgp) na zakladé

rozsahu nivnich pid. Poskytovatelem je Ceska geologicka sluzba

Cela podkapitola ,,5.2 Mapové podklady* byla zpracovana podle DRBAL
a kol. (2008) a webovych stranek CUZK (online: www.geoportal.cuzk.cz).
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5.3 Rekognoskace terénu

Ptedbézna a podrobné rekognoskace terénu, je velmi dilezita ¢ast kazdého
matematického modelovani. Pfi prizkumu terénu se potizuje fotodokumentace. Na
zaklad¢ potizené¢ fotodokumentace a zjiSténych skutecnosti se zadavd a piesné
specifikuje ptipadné doplitkové geodetické zaméfeni terénnich prekazek, stavebnich
objektii na toku, ¢i stavebnich objektl v bezprostiedni blizkosti toku. Dale se
z rekognoskace terénu urcuje charakter povrchu v koryté. Z téchto znalosti vychazi
napft. stanoveni hodnot drsnosti pouzitych ve vypoctech hydrodynamickych modela.
Rekognoskace je také dulezita pii oveéfovani aktudlniho stavu zajmové oblasti.
(DRBAL a kol. 2009). Na fotografiich ¢. 1 a ¢. 2 Ize vidét odlisné useky toku

Vv feSeném uzemi, které charakterizuji profil toku v pfevazné ¢asti zajmového tzemi.

%

Fotografie ¢. 1 — Usek toku ve spodni ¢asti zajmového tizemi V katastru obce Hrddek u Rokycan

Fotografie ¢. 2 — Usek toku ve stiedni ¢dsti zajmového iizemi v katastru obce Dobitv
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6. ANALYZA POVODNOVYCH RIZIK A SKOD V ZAPLAVOVEM UZEMI

,»Posuzovani miry povodiového nebezpeci, vyjadfovani povodiiovych rizik
a vySe moznych $kod patii k velmi aktualni tématim nejen ve vodnim hospodaistvi.*

(DRBAL a kol. 2008)

Je to dano 1 tim, ze Smérnice Evropského parlamentu a Rady
0 vyhodnocovani a zvladani povodinovych rizik (Directive of the FEuropean
Parliament and of the Council on the assessment and management of flood risks)
nafizuje c¢lenskym statim postupné v pevnych casovych terminech analyzovat
a vyhodnotit povodnové nebezpeci na jejich izemi. Terminy pro zpracovani této

problematiky jsou stanoveny takto:
- do 22. 12. 2011 dokon¢it pfedbézné vyhodnoceni povodiiovych rizik

- do 22. 12. 2013 zajistit dokonceni map povodiiového nebezpeci a map

povodiovych rizik

- do 22. 12. 2015 zajistit dokonceni a zvefejnéni plant pro zvladani

povodiovych rizik

V Ceské republice, byly pro zvladnuti téchto tkold vytvofeny zatim dvé
metodiky, které vypracovali na Vyzkumném ustavé vodohospodaiském T. G.
Masaryka. Jsou to Metodika stanovovani povodinovych rizik a Skod v zéplavovém
uzemi (DRBAL a kol. 2008) a Metodika tvorby map povodiového nebezpeci
a povodiovych rizik (DRBAL a kol. 2009). Celd tato kapitola 6. Analyza
povodnovych rizik a Skod v zaplavovém tizemi, byla vytvofena pomoci téchto dvou

metodik.

6.1 Analyzu povodnovvych rizik

Povodniové riziko je stanoveno jako pravdépodobnost vyskytu nezadouciho
jevu, ktery ma za nasledek neptiznivé G€inky na Zivoty, zdravi, majetek nebo zivotni
prostiedi.

Analyzu povodiovych rizik lze rozdélit na tii zakladni typy a to na

kvalitativni analyzy, kvantitativni analyzy a semikvantitativni analyzy.
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6.1.1 Kvalitativni analyza

Vyhodnocovéni je zaméfeno na identifikaci moznych udalosti tzv. scénéit
nebezpeci. Tyto scénafe nebezpeci upozoriiuji na potencidlni udalosti, které mohou
mit za nasledek Skody. Scénaie nebezpeci je poté zapotiebi jednotlivé analyzovat
avyhodnotit. Na zakladé vysledku této analyzy jsou uréeny typy nebezpeci

a soucasné¢ i systémy, kterym je zapottebi vénovat zvySenou pozornost.

6.1.2 Kvantitativni analyza

Zptsob vyhodnoceni této metody se opird o stanoveni pravdépodobnosti
koncového stavu celého systému a na zékladé pravdépodobnosti vyskytu
jednotlivych scénaft nebezpeci. Jako kvantifikator dil¢iho rizika se pouziva
pravdépodobnost vzniku potenciondlni Skody v rozsahu jednotlivého scéndie
nebezpeci. Hodnoti se pfima i nepiimé poskozeni, ptimé i nepiimé Skody a provadéji

se ruzné socialni, ekonomické analyzy i s ohledem na krajinu a Zivotni prostredi.

6.1.3 Semikvantitavni analyza

Je vnimana jako mezistupen mezi metodou kvalitativni analyzy, ktera
neukazuje ptfedstavu o rozsahu povodnového rizika a metodou kvantitativni, ktera
pro kvantifikaci rizika potfebuje velké mnoZzstvi presnych dat. Vysledkem
semikvantitativni analyzy je vyjadfeni relativni vySe rizika zobrazenym pomoci napf.

barevné stupnice ¢i Ciselné stupnice.

6.1 Analyza §kod v zaplavovém dzemi

Potencionalni Skody se vztahuji k movitému 1 nemovitému majetku
vV inunda¢nim Uzemi. Urceni metody, kterd se pouzije ke stanoveni povodiovych

Skod, zavisi na dvou faktorech.

- na potiebné podrobnosti (Uroviii podrobnosti | -> azemni celky,

sidla, ¢asti sidel a urovni podrobnosti II -> jednotlivé objekty).
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- na materialnich a poptipadé nemateridlnich $kodach v inundaénim
uzemi, majetky nebo jinak ocenéné hodnoty mohou byt riznou mérou

poskozeny, znehodnoceny, odplaveny, zaneseny.

Posuzuji a hodnoti se tyto potencionalni Skody:

- na bytovém fondu a vybavenosti byti, rodinnych domui i dal$ich obyt.

domi
- na ob¢anské vybavenosti (S8koly, zdravotnicka zafizeni, obchody, atd.)
- v dopravni infrastruktute a dopravée (silnice, zeleznice, atd.)
- Vv systémech inzenyrskych staveb
- ve vodnim hospodaistvi (vodni toky, vodni dila, kanalizace, atd.)
- v zemédélstvi (objekty, chov hospodaiskych zvirat, atd.)
- V lesnim hospodafstvi

- Vv primyslu, energetice, sluzbach a té¢Zb¢ surovin

Kazda z uvedenych oblasti ma svoje specifické vlastnosti, proto analyzy pro
jednotlivé typy oblasti mohou byt odlisné. To vSe je podrobné popsano, jak jiz bylo
feceno, V metodikach pro stanovovani povodnovych rizik a Skod v zaplavovém
uzemi (DRBAL a kol. 2008) a pro tvorbu map povodiového nebezpeci
a povodnovych rizik (DRBAL a kol. 2009), podle kterych byla tato kapitola stru¢né

zpracovana.
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7. CHARAKTERISTIKA RESENEHO UZEMI

Znalost charakteristiky uzemi je nezbytnd pro hydrologické modelovani.
| kdyZ je izemi, které budu v této praci feSit pouhou ¢asti z povodi feky Klabavy, je

nutné znat charakteristiky celého povodi.

7.1 Geografické charakteristiky

Povodi se nachazi v Zapadnich Cechach, leZi na hranicich Plzeniského kraje
s krajem Stiedoceskym, dale spada z velké Casti pod okresy Rokycany a Ptibram
astednd pak zasahuje i do okresti Plzen-mésto a Beroun. Resené uzemi se tahne od
hranice kraji StiedoCeského a Zapadoceského déle na zapad a lezi na katastralnim

uzemi obci StraSice, Dobiiv a Hradek u Rokycan.

Vodni tok Klabava prameni ve vojenském tjezdé v Brdské pahorkating ve
vySce asi 760 m n. m. a vléva se jako pravostranny pfitok do regionalné
nejvyznamngéj$iho toku Berounky u obce Chrast. V starsi literatufe miizeme horni tok
Klabavy najit pod ndzvem Padrt’'sky potok, takto je oznaCovan usek od pramene az
po soutok s Holoubkovskym potokem u mésta Rokycany, dale po proudu byl tok
nazyvana jako dnes, Klabava. Nazev nese podle jedné obce, ktera lezi na pravém

biehu toku pobliZz Rokycan.

Obrazek ¢. 1 — Mapa ceské republiky s polohou povodi reky Klabavy
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Obrazek ¢. 2 — Podkladova mapa z Www.cenia.cz s povodim reky

Klabavy a vyznacenym resenym vizemim

7.2 Hydrologické charakteristiky

Povodi Klabavy je soucasti povodi Berounky coz je povodi III. fadu, které ma
¢islo hydrologického potadi 1-11 -01. Samotné povodi Klabavy je slozeno z nékolika
povodi IV. fadu s ¢islem hydrologického potadi 1-11-01-006/0 az 1-11-01-040/1.

(online: www.dibavod.cz).

Celkova plocha povodi je 372 km?, kterou protéka vodni tok Klabava
o celkové délce 49 km (VLCEK a kol. 1984). Zakladnimi hydrologickymi
charakteristikami povodi jsou data o pratocich, bez kterych by se zadné hydraulické
modelovani neobeslo. Typt dat o pratocich je celd fada, napt. max. pratok, min.
pritok, primérny ro¢ni pritok, M-denni pritoky a N-leté pritoky. Pro nas ucel tedy

pro stanoveni hranic zaplavovych uzemi pii rizné velikosti povodné, jsou

vvvvv

Hodnoty pratokt se zjist'uji na monitorovacich stanicich, které jsou umistény
na tocich. K ucelu této prace je zapotiebi znat N-leté pritoky na zacatku a na konci
feSeného uzemi, tyto hodnoty pak pouziji jako vstup do 1D hydrodynamického
modelu. Potfebuji tedy znat hodnoty ze dvou monitorovacich stanic. V dolni ¢asti
feSen¢ho izemi se nachazi monitorovaci stanice v obci Hradek u Rokycan a v horni

¢asti se nachazi monitorovaci stanice v obci StraSice.
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Zaokrouhlené¢ hodnoty N-letych pratoki na monitorovaci stanici V Hradku
u Rokycan s plochou povodi 158,45 km® a monitorovaci stanici Strasice s plochou
povodi 73,24 km? jsou patrné z tabulky &. 1 (online: www.pvl.cz; in verb Ing.
Grunwaldova, 1V/2012).

N - letost [ . s7!]
Q; Q> Qs Q1o Q20 Qso | Quio00

StraSice 9 14 23 32 42 57 70

Nazev stanice

Hradek u Rokycan| 17 26 43 58 76 104 129

Tabulka ¢ 1 — Zaokrouhlené hodnoty N-letych priitokit ddle pouzité v matematickém modelu

Z historického pohledu byla v této oblasti nejvétsi povoden v roce 2002 a to
konkrétn¢ dne 12. 8. 2002, kdy byla na monitorovaci stanici v Hradku u Rokycan
zjisténa vice jak 100-letd povoden, bohuzel vSak chybi ptesny zdznam o velikosti
pritoku. N-letost nejvétsi zaznamenané historické povodné a hodnotu pritokd na
monitorovacich stanicich lze ovéfit v pfiloze ¢. 1 Kopie hlasného profilu Hradek

u Rokycan a pfiloze ¢. 2 Kopie eviden¢niho profilu StraSice.

7.3 Klimatické charakteristiky

Klima je vysledkem dlouhodobého pusobeni nékolika aspektd, jako jsou
vSeobecné cirkulace vzduchu, plsobeni radia¢nich pomérti, vlastnosti podkladu
(nadmotskd vyska, tvar terénu, orientace a sklon terénu, schopnost pohlcovat
a odraZzet slunecni svit) a také ovlivnéni antropogenni Ccinnosti. Klimatické
charakteristiky se klasifikuji na zéklad¢ klimatickych pomért s ohledem na vzajemné
zavislosti mezi jednotlivymi meteorologickymi sloZkami. Klimatickych klasifikaci
existuje cela fada, asi nejvice vyuZivanou klasifikaci v Ceské republice je Quittova
klimaticka klasifikace. Quittova klasifikace klimatu obsahuje 23 jednotek zatfazenych
do 3 hlavnich oblasti teplé (T), mirn¢ teplé (MT) a chladné (CH) oblasti (TOLASZ
a kol. 2007).

Dle Quitta (1971) se vpovodi Klabavy vyskytuje 6 jednotek Quittovy
Klasifikace, jsou jimi CH7, MT3, MT5, MT7, MT10 a MT11. V horni ¢asti toku

Klabavy, zejména v Brdské pahorkatiné se vyskytuje klimatickd jednotka CH7, ktera
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nize po toku prechazi postupné v tyto klimatické jednotky MT3, MT5, MT7, MT10
ave spodni casti toku dale v klimatickou jednotku MT11 vice ptiloha ¢. 3.
Charakteristiky jednotlivych klimatickych jednotek, které se vyskytuji v izemi, jsou

popsany v piiloze €. 4.

7.4 Geologické charakteristiky

Geologické poméry maji velky vliv na vsak srazkové vody v povodi a to
v zavislosti na uloZeni geologickych vrstev a hodnoté propustnosti téchto vrstev.
Povodi se zastoupenim propustnych hornin velmi vyrazné ovliviiuje rozdéleni odtoku
ze srazek a tim nepfimo ovliviluje extrémni pratoky v povodi, neboli v koryté
toku. Pti vysokych a intenzivnich srazkach tyto povodi nemaji tak velké kulminaéni
pritoky, jako povodi s nepropustnymi horninami a zaroveil pii obdobi sucha jsou
povodi s propustnymi horninami Vv dasledku lepSich akumulac¢nich schopnosti
vodnatéjsi a nedochézi tak casto k vyraznému zmenSeni prutokd, nebo dokonce
k vysychani koryta jako v povodi s nepropustnymi horninami (KEMEL 2000). Dale
ovliviiuji vznik dalsiho velmi vyznamného faktoru, ktery ovliviiuje odtok ze srazek
atim je slozeni pidy nebo také pedologické poméry v povodi, jelikoz ptida vznika

zvétravanim svrchni vrstvy hornin

Resena oblast spada z geologického hlediska do Ceského masivu dale pak Ize
toto tizemi rozdélit na Stredoceskou oblast, na Barrandienské svrchni proterozoikum
a Barrandienské spodni paleozoikum (BRUNCLIK a kol. 1986). Barrandienské
komplexy jsou z geologického hlediska ohraniCeny na JZ az Z krystalinikem
Ceského lesa a Tepelskou plosinou, na SZ az S pak komplexy Barrandienu zajizdi
pod permokarbonské uloZeniny kladensko-rakovnické panve a pod souvrstvi svrchni
kiidy, smérem k SV a V se déle tdhnou algonkicka, eokambricka a staropaleozoicka
souvrstvi Barrandienu az pod sedimenty vychodoceské kiidové panve a navazuji na
preménéné algonikum a starsi paleozoikum podhtii Krkonos$ a Orlickych hor, z JV
jsou pak barrandienské komplexy omezeny zejména stiedo¢eskym Zulovym

plutonem (SVOBODA a kol. 1964).

V povodi Klabavy maji jednozna¢né nejvétsi zastoupeni paleozoické horniny
zvrasnéné a nemetamorfované (biidlice, droby, kiemence, vapence), dalsi pomérné

siln¢ zastoupené horniny, zejména pak v dolni ¢asti povodi a na zapadni hranici
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povodi, jsou proterozoické horniny assyntsky zvrasnéné s rizné silnym variskym
pfepracovanim (bfidlice, fylity, svory az pararuly). Mezi horniny, které nemaji
Vv povodi az tak hojné zastoupeni, ale Ize je najit ostrivkovité rozmisténé v horni
¢asti povodi patii vulkanické horniny z¢asti metamorfované z obdobi proterozoika az
paleozoika (amfibolity, diabasy, melafyry, porfyry), poslednimi horninami, které
nejsou zastoupeny az tak hojné, ale je dobré je zminit, jsou horniny z kvartéru (hliny,
spraSe, pisky, Stérky) vyskytujici se ve spodni ¢asti povodi (online:

www.geology.cz).

7.5 Pedologické charakteristiky

Pedologické poméry jsou dalsim velmi vyznamnym faktorem ovliviiujici
rozdéleni odtoku ze srdzek na odtok povrchovy a podpovrchovy a tim ovliviiuji

i pribéh povodiiové viny v toku (HRADEK, KURIK 2008).

V povodi Klabavy se pifevazné nachazeji pidy oznacovany jako pseudogleje
s hnédymi plidami oglejenymi a hnédé pudy kyselé. Dale se zde vyskytuji hnédé
pudy siln€ kyselé, illimerizované pidy s illimerizovanymi pidami oglejenymi
a ojedinéle se objevuji i hnédé pudy s podzoly na terasovych ulozeninach, hnédé
pady se surovymi ptidami a raeliniitni pady (TOMASEK 2003). Pfesné rozdéleni

pud v oblasti je ptilozeno Vv piiloze €. 5.

Podle TOMASKA (1995), maji pseudogleje malou zemédélskou hodnotu a je
potieba u tohoto pliidniho typu Uprava vodniho rezimu pro zlepSeni vlastnosti pidy.
Vhodnymi plodinami pro péstovani jsou hlavné obiloviny, dale pak jetel a v niz§ich
polohach i vojtéska nebo cukrovka. Druhy hojné zastoupeny hlavni pidni typ
v lokalité je hnéda puda, kterd je nejéastéj$im pidnim typem v Ceské republice.
Hnédé pady jsou z hlediska zeméd¢€lské hodnoty stfedni az nizsi kvality, vzhledem
k tomu, Zze v povodi se vyskytuje zejména subtyp hnédé pudy kyselé, je zeméd¢lska
kvalita pidy spiSe nizs§i. Tato piida je vhodna pro péstovani obilnin (je¢men,

pSenice), brambor, nebo je lze vyuzit jako lesni stanoviste.

31



Lukas Toman Metodika

7.6 Vegetacni a krajinny pokryv

Vegetacni pokryv a hlavné potom lesni pokryv ma dvé funkce. Za prvé chrani
pudni horizont pfed eroznimi vlivy dest¢ a za druhé piimo ovliviiuje srazko-

odtokovy proces (HANZLOVA a kol. 2006).

Dnes se Casto vyuziva databaze krajinného pokryvu CORINE Land Cover.
Cilem projektu je tvorba a aktualizace databaze krajinného pokryvu jednotnou
metodikou pro uzemi celé Evropy. Vystupem jsou polygonové mapy vegetacniho
pokryvu v méfitku 1:100 000, které ukazuji jednotlivé zastoupeni krajinného
pokryvu v roce, kdy byla mapa vytvoiena. Vegetacni pokryv je rozdélen do 44 tiid

(online: www.cenia.cz).

Na tzemi povodi Klabavy je podle databaze CORINE Land Cover
V nejvétsim métitku krajinny pokryv zastoupen jehli¢natymi lesy a zemédélskymi

plochami vice ptiloha ¢. 6.
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8. STANOVENI ZAPLAVOVEHO UZEMi A VYTVORENI RASTSRU
HLOUBEK V ZAPLAVOVEM UZEMIi

K splnéni cile této bakaldiské prace tedy stanoveni zaplavového Uzemi
a vytvoreni rastru hloubek v zéplavovém uzemi pro povodiové scénare o velikosti
kulmina¢niho priatoku Q2g, Qso, Q100 je zapotiebi zvolit vhodny pocitacovy program,

nebo kombinaci nékolika programti, za pomoci kterych je mozno tento cil realizovat.

K zpracovani prostorovych dat, tvorbu tematickych map a tvorbu DMT jsem
pouzil program ArcGIS 9.3, konkrétné jeho aplikace ArcMap a ArcCatalog. Soucasti
tohoto programu musi byt nainstalovany i jeho extenze 3D Analyst, Spatial Analyst
a ArcHydro, tyto extenze jsou nezbytné pro chod nékterych funkci ArcGISu
pouzitych v bakalafské praci. Tento software byl pouzit i k naslednym analyzdm

vysledkt matematického modelu a k jejich vizualizaci.

Dalsim dilezitym softwarem potifebnym pro zhotoveni této bakalarské prace
je program pro zpracovani samotného matematického modelu v feSeném uzemi. Pro
tento kol jsem si ze Siroké nabidky softwart uréenych K této problematice vybral
pocitacovy program HEC-RAS 4.1.0, ktery byl vyvinut armadnimi inzenyry
Spojenych stati americkych. K vybéru tohoto programu mé vedla jeho snadnd
dostupnost a bezplatna moznost vyuziti. Dal$im divodem bylo i vyuZzivani tohoto
programu odborniky zabyvajicimi se hydrologickym modelovanim po celém svété
véetné Ceské republiky, coz je podle mé ukazatelem kvality tohoto programu.
Poslednim diivodem je dobra komptabilita HEC-RASu s programem ArcGIS. Pro
efektivni a jednoduché prevadéni formatd mezi témito dvéma softwary jsem pouzil
nadstavbu HEC-GeoRAS v kterém byla také vytvorena geometrie vodniho toku

V feSeném uzemi.

8.1 Prace v prostredi ArcGIS 9.3

Geografické informacni systémy (GIS) maji uplatnéni v mnoha védnich
oborech, jednim z nich je i hydrologie. Hlavni pfednosti GIS je prace S prostorovymi
daty a jejich nasledné analyza (JEDLICKA, STYCH 2007).

Z PVL mi byly poskytnuty data ptfevazn¢ ve formatech dgn, coz je format

s kterym nelze piiliS dobfe pracovat v prostiedi ArcGIS, proto je nutné tyto data

prevést do formatu shp. To jsem proved nasledujicim zptsobem. Do aplikace
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ArcMap jsem nahral data z PVL ve formatu dgn. Data byla v n¢kolika typech. Pro
m¢e byly dilezité body a linie, obé tyto ¢asti jsem postupné pievedl do formatu shp
ato tak, ze byl piislusny datovy soubor oznacen v obsahovém okné (Table of
content), zde za pomoci pravého tla¢itka mysi jsem rozvinul nabidku, kde byla
oznacena moznost Data -> Export data. Nasledné byla uloZena cesta k ulozeni nové
vzniklého shp nazvaného ,,Bod pole* a stejnym postupem jsem vytvoiil i shp

s nazvem linie. DMT.

8.1.1 Tvorba digitalniho modelu terénu (DMT)

Jako prvni krok bylo potieba vytvotit hydrologicky korektni DMT. Pfesnost
vytvofeného DMT s ohledem na redlny povrch je jeden ze zdsadnich faktorii
ovliviiuyjici pfesnost a pravdivost vystupt celého hydrologického modelu a tedy i celé

prace.

Pro zpracovani prostorovych dat je zapotfebi zvolit vhodnou strukturu
datového modelu, v které budou data ulozena. Pouziva se vektorovy datovy model
TIN, kde je povrch definovan jako nepravidelna trojiihelnikova sit’. Dal§i moznosti je
rastrovy datovy model GRID, ten se ukladda jako pravidelnd ctvercova mitizka, kterd
je v soutfadnicovém systému jasn¢ definovana pocate¢nim bodem, dale velikosti
buiiky, poc¢tem bun¢k ve sméru X (tadky) a Y (sloupce). Kazdé tato buiika ma pak
udaj se svoji hodnotou (napf. nadmoiskou vyskou). Oba tyto datové modely maji své
klady a zapory a je zapotiebi zvolit jejich pouZiti v zavislosti na Clenitosti povrchu,
ale také typu a hustoté vstupnich dat. Vstupnimi daty mohou byt napiiklad vyskové
body, 3D linie jako tfeba vrstevnice, nebo kombinace vice vstupnich dat

(JEDLICKA, MENTIK 2002; BURIAN 2008).

Jak fekl KLIMANEK (2006) obecné lIze ¥ici, Ze datova struktura TIN je pro
tvorbu DMT velmi vhodnym nastrojem a to i protoze lze do struktury TIN efektivné
zaClenit 1 povinné hrany terénu a tim kontrolovat interpolaci trojihelnikl v téchto

mistech.

Ja jsem si pro tvorbu DMT v feseném uzemi vybral vzhledem k formé dat
z PVL, tedy dat ve formé bodového pole vyskovych boda v kombinaci s vyraznymi

terénnimi liniemi (terénni hrany, terénni lomy) strukturu datového modelu TIN.
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TIN jsem vytvoril pomoci zalozky v ArcMAPu: 3D Analyst ->
Create/Modify TIN -> Create TIN from features. Hlavnimi vstupnimi parametry jsou
zde nadmotské vysky (elevation), nastaveni vstupnich parametrt si lze prohlédnout

na obrazku. ¢. 3.

Create TIN From Features LE

~Inputs

Check the layer(s) that will be used to create the TIN. Click a layer's name to
spedify its settings.

Layers:

[linie_pMT

zajmove_uzemi Height source: IEIevat'on hd l
Triangulate as: Imass points 'l
Tag value field: |<None> 'l

@l Settings for selected layer
Feature type: 3D points

OutputTIN: | C:\BP_Toman\DATAprojektitin g

oK I Cancel |

Obrazek ¢. 3 — Nastaveni vstupnich parametrii pri tvorbé TINu

Abych v DMT zohlednil i vyznamné terénni hrany, bylo zapotiebi editovat
stavajici TIN. To jsem proved za pomoci nastroje ArcToolbox -> 3D Analyst Tools
-> TIN Creation -> Edit TIN. Jako vstupni vrstvu vyznamnych terénnich hran jsem

pouzil vrstvu ,linie DMT®, kterou jsem ziskal ze sady dat od PVL. Rozdily

ptivodniho a editovaného TINu jsou patrné z obrazki ¢. 4 a €. 5.

A

Obrazek ¢. 4 — Pivodni TIN Obrazek ¢. 5 — Editovany TIN

Z diivodu malé podrobnosti bodovych dat v extravilanu TIN nedokazal
zachytit prib¢h koryta toku v uzemich mezi obcemi. V obcich byla podrobnost dat

kompenzovana liniovymi daty, kterd vystihovaly trasu koryta, pfesnéji biehové hrany
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a dno koryta. Tato liniova data vSak v extravilanu chybéla, proto zde neni koryto
toku zahrnuto v DMT. Pro spravny vypocet hydrologického modelu je to vSak
zasadni véc. Proto je zapotfebi pouzit n€kterého nastroje GIS a koryto v téchto

usecich vytvofit dodatecné.

K feSeni tohoto problému byla vyuzita extenze ArcHydro konkrétné nastroj
DEM Reconditioning, timto nastrojem lze zahloubit libovoln¢ veliké uzemi do
puvodniho DMT. Nastroj si ovSem zada jako vstupni vrstvu rastrovou datovou
strukturu, proto musime nejdiive mnou vytvofeny TIN pfevést na GRID. Tento tkol
provedu pomoci zalozky v panelu nastroji 3D Analyst -> Convert -> TIN to Rastr.
Dulezité v tomto nastroji je nastavit vhodnou hodnotu velikosti rastru (Cell size).
Velikost rastru by méla byt tak jemna, aby dostate¢né vystihovala charakter feSeného
uzemi. Zaroven by vSak neméla byt zbyte¢né moc jemnd, aby svym objemem dat
pfehnané nesnizovala jednotlivé vypoCty a zobrazovani rastru. Ja jsem si zvolil

velikost rastru 1 x 1metr.

Ted je potieba naeditovat tseky, které budu zahlubovat do DMT. Vytvoiim
si liniové vrstvy shp, které budou znazornovat koryto toku Klabavy v lese, koryta
pritokti @ ndhony na rybniky. Rozméry (hloubka, $itka) a trasa téchto objekti byly
zjistény z rekognoskace terénu a z ortofotomap. Dale uz mzu bez problému
pokracovat v ipravé DMT. Pro samotné zahloubeni naeditovanych liniovych vrstev
jsem pouzil nastroj v Arctoolbox -> ArcHydro -> Terrain Preprocessing -> DEM
Reconditioning. Rozdily mezi ptivodnim rastrem a vyslednym rastrem po pouziti

nastroje DEM Reconditioning lze vidét na obrazcich ¢. 6 a ¢. 7, kde je viditelné

RS

zahloubeni liniovych vrstev do DMT.

k

A

Obrazek ¢. 6 — Puvodni rastr Obrazek ¢. T— Vysledny rastr
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8.1.2 Tvorba geometrie vodniho toku s pomoci extenze HEC-GeoRAS

Pro vytvoreni geometrie vodniho toku jsem pouzil nadstavbu HEC- GeoRAS
a to hlavné diky nasledné jednoduchosti vyexportovani vysledné geometrie toku

Z prostiedi ArcGIS do prostiedi HEC-RAS.

Jako prvni jsem si v nadstavbé HEC-GeoRAS nastavil s jakym DMT bude
HEC-GeoRAS po vytvoreni vSech potfebnych vrstev pracovat. Proto bylo zapotiebi
oteviit nastaveni vrstev v HEC-GeoRAS -> RAS Geometry -> Layer setup. Zde jsem
si nastavil, ze budu pracovat s datovou strukturou GRID konkrétné s rastrem

pojmenovanym ,,agreedem3*, coz je mij vysledny DMT vice obrazek ¢. 8.

F{i Layer Setup

Required Surface | Required Layers ] Cptional Layers I Optional Tables

) Terrain Type = TIN * GRID
* Single
Select Terrain |agreedem3 ﬂ
" Multiple DTM Tiles Layer [ it -]

Obrazek ¢. 8 — Vyrez z okna Layer Setup

Prace v nadstavbé HEC-GeoRAS probihala ve tfech krocich. Nejprve jsem si
vytvofil vrstvy potiebné k mému projektu. Tyto vrstvy jsem nasledné editoval
a nakonec doplnil jejich atributové tabulky. Pro moji praci jsem pouzil vrstvy Stream
Centerline (osa toku), Bank Lines (biechové linie), Flow Path Centerlines (proudnice),
XS Cut Lines (pti¢né profily). HEC-GeoRAS nabizi daleko vice pfedefinovanych
vrstev, avSak pro moji praci jsou tyto Ctyii vrstvy dostatecné. VSechny vrstvy
pfiddme pomoci nastroje, ktery najdeme v panelu nastroji HEC-GeoRAS -> RAS
Geometry -> Create RAS Layers ->. .. ... (obrazek €. 9).
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RAS Geometry ~ RAS Mapping ¥ i< it Ll & = < & Apuiil
I

Layer Setup Bank Lines

Stream Centerline Attributes  p iy 2Ll
Flow Path Centerlines

XS Cut Line Attributes » ¥S Cut Lines

Manning's n Values » Bridges/Culverts

Levees 3 Ineffective Flow Areas

Ineffective Flow Areas » Blocked Obstructions

Blocked Obstructions » Landuse Areas

Bridges/Culverts » Levee Alignment

Inline Structures b iEEE s

Lateral Structures 3 LT3 ST £t

Storage Areas » Lateral Structures

Storage Area Connections b AITIReTEE

Export RAS data Storage Area Connections
Terrain Tiles

e = ’ Terrain Split Lines

Utilities » All

Obrazek ¢. 9 — Nastroj Create RAS Layers s otevienou nabidkou predefinovanych vrstev

Po vloZeni vSech potfebnych vrstev jsem zacal jednotlivé vrstvy editovat.

Editaci jsem zapnul pies panel nastroji Editor -> Start Editing.

Jako prvni jsem editoval vrstvu Stream Centerline (0sa toku), pomoci nastroje
Sketch Tool. Zakladnim pravidlem je editovat osu toku po sméru proudéni vody
Vv koryté, neboli editovat od horni ¢asti toku po dolni ¢ast toku. Je to z toho diivodu,
ze pti exportu dat si model HEC-RAS smér editovani ulozi jako smér proudéni vody
Vv koryté toku. Jako podklad pro zakresleni trasy koryta Klabavy v zajmovém uzemi
jsem pouzil ortofotomapu dostupnou na webovych strankdch www.geoportal.gov.cz.
Pomoci této mapy jsem zakreslil vrstvu Stream Centerline do koryta toku. Po
ukonceni editace byly vyplnény atributy nazev toku (river) a HydrolD v atributové

tabulce.

Druhou vrstvou potiebnou naeditovat byla vrstva Bank Lines. K editovani
této vrstvy jsem pouzil funkci Copy Parallel. Editaci jsem provedl tak, ze jsem
oznacil vrstvu Stream Centerline a zvolil vzdalenost bifehového linie toku od osy
toku. Tato vzdalenost je samoziejmé podél toku v kazdém profilu proménna. Proto
jsem pouzil primérnou hodnotu, kterd se v feSené oblasti vyskytuje. Pramérnou

hodnotu jsem urcil z rekognoskace terénu a z ortofotomapy.
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Tteti vrstvou v potadi pfipravenou K editaci byla liniova vrstva Flow Path
Centerlines. Tato vrstva je totozna s vrstvou Stream Centerline, proto byl tvar vrstvy

Stream Centerline pouze zkopirovan do vrstvy Flow Path Centerlines.

Jak posledni jsem vytvofil nejdilezitéjsi vrstvu XS Cut Lines. Pii tvorbé této
vrstvy bylo potieba dbat ne€kolika pravidel. Jednim z téchto pravidel je, aby veskeré
XS Cut Lines byly kolmé na osu toku a zaroven prochazely celym budoucim
zéplavovym uzemim. DalSim pravidlem je to, Ze se jednotlivé piicné profily nesmi
kiizit. Pro vykresleni ptiénych profila jsem pouzil funkci Construct XS Cut Lines.
V této funkci byly nastaveny parametry, které jsem zvolil s ohledem na geometrii
toku, DMT a rozsah dat. Interval mezi jednotlivymi pficnymi profily byl zvolen jako
100m a rozsah piicnych profila 300m, jak lze vidét také na obrazku €. 10. PouZzitim
funkce Construct XS Cut Lines doslo k dodrzZeni tfetiho pravidla. Toto pravidlo zni

tak, ze kazdy pficny profil musi byt tvofen zleva doprava po sméru toku.

F{: Create Cross Sections ﬁ
XS Cutlines |%SCutLines -
Stream Centerline |Hi\rer j
Interval lm}i
\nfidth 300

] | Help | Cancel |

Obrazek ¢. 10 — Dialogové okno Create Cross Sections s nastavenymi parametry

Po vytvofeni pfi¢nach profild v disledku relativné velké Siiky pfi¢nych
profilli a vlnici se trasy toku se porusila jedna podminka, konkrétné zakaz ktizeni
jednotlivych pficnich profild. Proto bylo zapotiebi tyto jednotlivé chyby manualné
Vv editacnim rezimu odstranit. Rozdily pfi¢nych profili ve vybrané ¢asti uzemi po
pouziti nastroje Construct XS Cut Lines a nasledném editaci je zcela evidentni

Z obrazku ¢. 11 a ¢. 12.
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Obrazek ¢. 11 — PFicné profily po vytvoreni funkci Construct XS Cut Lines

Obrazek ¢. 12 — Pricné profily po editaci

Po dokonceni editace vSech Ctyt vytvorenych vrstev, bylo zapotiebi do vrstev
Stream centerline a XS Cut Lines doplnit vSechny potfebné atributy do atributovych
tabulek.

Nejjednodussi zptsob jak doplnit atributové tabulky je pouzit funkce, které
vypoétou a doplni piislusné hodnoty do atributovych tabulek a zaroven vytvofi

totoznou vrstvu s vySkovymi charakteristikami (Elevation).

Pro vrstvu Stream Centerline jsem pouzil funkci z panelu nastroji HEC-
GeoRAS -> RAS Geometry -> Stream Centerline Attributes -> All. Tato funkce

vypocte atributovou tabulku Stream Centerline a zaroven vytvofi novou totoznou
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vrstvu, kterd je ovSem doplnéna o vySkové charakteristiky (Elevation). Vstupni

parametry jsou zietelné na obrazku ¢. 13.

F:E All Stream Tools Iﬁ
Stream Centerline |H.i\.-'EF ﬂ
Terrain |agreedem3 ﬂ
Stream Profiles |River3D

Ok Help Cancel

Obrazek ¢. 13 — Dialogové okno se vstupnimi parametry pro automatické doplnéni hodnot

do atributové tabulky vrstvy Stream Centerline

Funkce k vypoétu atributi a doplnéni o vySkové charakteristiky (Elevation)
pro vrstvu XS Cut Lines se nachazi v zdloZzce HEC-GeoRAS -> RAS Geometry -> XS
Cut Line Attributes -> All, po pouziti této funkce se opét vytvoii totozna vrstva
s vySkovymi charakteristikami (Elevation). Nastaveni vstupnich parametrii pro tuto

funkci si lze prohlédnout z obrazku ¢. 14.

[E All Cross-Section Tools ot
Stream Centerline | River ]
Bank Lines |Banks |
Flowpaths | Flowpaths |
XS Cutlines | XSCutlines |
Terain |agreedem3 |

XS Cutlines Profiles  [XSCutLines3D

QK Help Cancel

Obrazek ¢. 14 — Dialogové okno se vstupnimi parametry pro automatické doplnéni hodnot

do atributové tabulky vrstvy XS Cut Lines

8.1.3 Export geometrie toku

Export dat geometrie toku do formatu, ktery Ize pouzit v hydrodynamickém

modelu HEC-RAS jsem provedl pies extenzi HEC-GeoRAS. Konkrétné pies zalozku

41



Lukas Toman Metodika

HEC-GeoRAS -> RAS Geometry -> Export RAS data. Data jsem ulozil na pevny
disk, odkud jsem je dale importoval do HEC-RASu.

8.2 Prace v prostiredi HEC-RAS 4.1.0

Po tom co jsem vytvoiil DMT a geometrii vodniho toku v z4jmovém uzemi,

bylo vse ptipravené pro tvorbu hydrologického modelu v softwaru HEC-RAS.

8.2.1 Zakladni nastaveni softwaru

Po spusténi programu HEC-RAS se mi zobrazilo zakladni okno, kde bylo
zapotiebi nejdiive zalozit novy tzv. projekt a ulozit na cilové misto na disku. Ja jsem
tento datovy soubor nazval ,,Project BC*. Po vytvofeni projektu jsem musel nastavit
jednotkovy systém, se kterym bude program pracovat. Vzhledem k tomu ze program
je od americkych tviirct, jsou predefinované americké jednotky. Zménu amerického
jednotkového systému na jednotkovy systém soustavy SI provedeme v HEC-RASu
ptes zalozky Options -> Unit systém (US customary/SI)..., kde zaSkrtneme pole

Systém International (Metric System).

8.2.2 Nastaveni geometrickych dat

Nejdiive bylo nutné nahrat geometrické charakteristiky vytvotené v softwaru
ArcGIS. Nejprve jsem si oteviel zakladni okno pro praci s geometrickymi daty pies
zalozku Edit -> Geometric Data.... Vtomto okné jsem provedl nahrani dat
ptipravenych geometrickych dat pies zalozky File -> Import Geometry Data -> GIS
Format.... Po nahrani geometrickych dat se mi zobrazila v zdkladnim okné
geometrie vodniho toku. Nasledné jsem geometrii toku ulozil na disk pod ndzvem
»Geometrie*. Geometrii zobrazenou v zakladnim okné pro praci s geometrickymi

daty si Ize prohlédnout na obrazku ¢. 15
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¢ Geometric Data E‘E—@
Fie Edit Options View Tsbles Tools GISTools Help
o] B e | oo | G| | 2 ‘@ Description T [LJPews etertetaPoie: [ ]
= b= O
Junet I

Crass
Section

7300,
/s 00
330034002700
iy

79508568, -1074234.07

Obrazek ¢. 15 — Importovana geometrie toku z prostiedi ArcGIS, zobrazend v zakladnim okné

pro prdci s geometrickymi daty v programu HEC-RAS

Protoze typ povrchu vyrazné ovlivituje rychlost proudéni vody, bylo dilezité
zadat hodnoty drsnosti povrchu do modelu. Model HEC-RAS pracuje s drsnostnim
soucinitelem podle Manninga, ktery jsem Vv zajmovém tUzemi stanovil pomoci
rekognoskace terénu. Hodnoty jsem do modelu vlozil pomoci zalozky v zakladnim
okné pro praci s geometrickymi daty, Tables -> Mannin's n or k values (horizontally
varied).... Drsnosti byly zvoleny pro kazdy profil stejné tedy pro celé zajmové izemi

konstantni, jak je vidét z tabulky na obrazku ¢. 16.

Edit Manning's n or k Values
River: |K|a|:|ava j ﬁ g v Edit Interpalated =5's Channel n%alues have
a light green
Reach: |leka backaround
Selected Area Edit Options
Add Conztant ... uiltiply Factar ... | SetValues ... | FReplace ... | FReducetoLChR .. |
River Station Frctn n/k] | n #1 | n 2 | n 3 -
110100 h 033 033 033
2] 10000 h 033 033 033
3| 5500 h 033 033 033
4 8800 n 033 033 033
5| 9700 h 033 033 033
| 9500 h 033 033 033
7| 9500 h 033 033 033
2 9400 h 033 033 033
9| 5300 h 033 033 033 j
(] Cancel Help

Obrazek ¢. 16 — Zaddani hodnot soucinitele drsnosti dle Manninga do softwaru HEC-RAS
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Poslednim krokem v nastaveni geometrie toku bylo jednotlivé zkontrolovat
a vytipovat tvarové rozmanité profily a to z divodu, jakym zplisobem probihd plnéni
vody v profilech. Voda se plni podle hodnoty nadmotiské vysky od zdola nahoru,
kvuli této skuteCnosti je nutné v nékterych profilech oznacit bod funkci levees, kterou
najdeme v zakladnim okné pro praci s geometrickymi daty Cross Sections ->
Options -> Levees, ktera zajisti, ze uzemi za timto bodem se zacne plnit az
v okamziku, kdy voda z koryta dosahne tohoto bodu. Pro prezentaci této funkce jsem
si vybral profil se stani¢enim 9600. Na obrazcich ¢. 17 a €. 18 je zfetelné vidét jak

nastroj levees funguje.

Legend

EG Q100
WS Q100

3 Crit @100
4845
Ground

-
Bank Sta

4940

4935 R
e \/J_/

492.5°

Elevation (m)

432.0

491.5

Station (m)

Obrazek ¢. 17 — Plnéni pricného profilu se stanicenim 9600 bez pouZiti funkce levees

3 EEEa) E5)

4845 Crit 0100
Ground
Levee

-
Bank Sta

4940

4035

Elevation (m)

483.0

4925

492.0

4915

Station (m)

Obrazek ¢. 18 — Plnéni pricného profilu se stanicenim 9600 s pouziti funkce levees
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8.2.3 Nastaveni modelovanych scénafu

Zadani N-letych pritokd probéhlo pomoci ptikazu File -> Steady flow data
v zakladnim okné programu HEC-RAS. Zde bylo nutno pomoci pole Enter/Edit
Number of Profiles nastavit pocet scénaiti (pocet N-letych prutoki), pro které
probéhne vypocet. Pouzitim tlacitka Reach Boundary Conditions... byla nastavena
metoda vypoctu, vmém piipadé pomoci kritickych hloubek (Critical Deph).
Piedposlednim krokem bylo nastaveni poc¢ate¢niho a koncového profilu, tyto profily
ohraniCuji tizemi, ve kterém prob&hne vypocet, a to pies tlacitko Add Flow Change
Location. Na zavér uz bylo jen nutno naeditovat hodnoty N-letych prutokd pro

jednotlivé scénare. Edita¢ni okno ustaleného proudéni je na obrazku ¢. 19.

5= Steady Flow Data - Ustalene_proudeni E@ﬂ

File Options Help

Enter/Edit Number of Profies (25000 mas): [T Reach Boundary Conitions . | |

ocati yw [ata Changes
River [Klabawva ] Add Mulipl...
Reach: ,h‘ River Sta. Add & Flow Change Location
Flow Change Location Profile Mames and Flow Bates
Fifver Reach RS 01 |32 |35 |30 | 220 | @50 | 3100
1| Klabava reka 10100 |9 14 23 32 42 57 70

2| Klabava 1eka 100 17 26 43 58 76 104 129

|Select river station for adding a new flow change location.

Obrazek ¢. 19 — Zadané hodnoty priitokii v pocatecnim a koncovém profilu pro jednotlivé

scénare ustdaleného proudeni

8.2.4 Spusténi vypoctu modelu

Poté, co jsem si pfipravil vstupni parametry (geometrii, modelované scénare)
modelu, bylo zapotiebi spustit vypocet samotného modelu. Ten jsem spustil
v zakladnim pracovnim okné pomoci zalozky Run -> Steady Flow Analysis. Okno
pro spusténi vypoctu hydrodynamického modelu se zadanymi potfebnymi parametry

pro vypocet je vidét na obrazku €. 20.
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K Steady Flow Analysis lil_lﬂ—hj
File Optiens Help
Plan: [Plan 01 Shart I |Plan 01
Geometry Fils | Gieametrie_BC |
Steady Flow File : |Prut0k_l,l_BE ﬂ
Flow Regims Plan Description :
{* Subcritical B
" Supercritical
" Mixed
Eompute |
Enter to compute water surface profiles

Obrazek ¢. 20 — Okno Steady Flow Analysis pro spusténi vypoctu hydrodynamického modelu se

zadanymi parametry

8.2.5 Export vytvoieného modelu

Kdyz uspésné probéhl vypocet hydrodynamického modelu, bylo zapotiebi
ziskané vysledky patfi¢né prezentovat. Pro splnéni tohoto tkolu jsem si vybral znovu
program ArcGIS 9.3. OvSem praci v tomto programu piedchazel export souboru dat
pouzivanym softwarem HEC-RAS do souboru dat pouzivanym softwarem ArcGIS.
Export probéhl pomoci zalozky File -> Export GIS data ... v zékladnim okné
programu HEC-RAS. Po potvrzeni piikazu se zobrazilo okno GIS export, v tomto
okné jsem vybral modelované scénate, s kterymi chci déle pracovat a to pomoci
tlacitka Select profiles to Export. Po vybrani modelovanych scénait jsem vybér

potvrdil a data exportoval kliknutim na tlacitko Export Data.

8.3 Vvsledna vizualizace v prostiedi ArcGIS 9.3

Abych mohl zacit s vizualizaci vysledkd hydrodynamického modelu, musel
jsem nejprve importovat data do prostiedi ArcGIS. Toho jsem docilil pomoci tlacitka
RAS SDF File v zalozce HEC-GeoRAS. V tomto kroku byla data ve formatu sdf
transformovéana do formatu xml a tim doslo i k nacteni dat do ArcMapu, okno pro

transformovani dat je vidét na obrazku ¢. 21.

46



Lukas Toman Metodika

5] Convert RAS Export SDF to XML [ = |

RAS SDF File: C:\BP_Toman\DATA\HEC export_HEC_to_(3IS\Projekt_BC.RAS [
RAS XML File: CABP_Toman‘\DATANHECewport_HEC_to_GIS“Projekt_BC.RAS:

[ oK ] [ Close

Obrazek ¢. 21 — Okno k transformaci dat z_formdtu sdf do formdtu xml

Dalsi kroky byly provedeny pies zalozku HEC-GeoRAS -> RAS Mapping.
Prvnim funkci v oteviené nabidce byla Layer Setup, v této funkci bylo nutno nastavit
jméno nové analyzy (Analysis Type), hydrodynamicky model pomoci kterého bude
analyza provedena (RAS GIS Export File). Dale pak DMT ktery, bude pouzit pti
analyze (Terrain). Protoze vybrany DMT ma datovou strukturu GRID byla
automaticky vyplnéna i kolonka stanovujici velikost buiiky rastru (Rasterization Cell
Size) a to hodnotou shodnou s velikosti rastru vstupniho GRIDu. Jako
poslednim krokem v tomto okné je umisténi vytvofené analyzy na volné misto na
pevném disku (Output Directory). Okno nastroje Layer Setup S vyplnénymi

vstupnimi parametry si Ize prohlédnout na obrazku ¢. 22.

Ezl Layer Setup &J

Analysis Type
(" Existing Analysis J

(¢ New Analysis |‘\.-"|2ualizace_[}1 00

RAS GIS Export File |C:"'-.E P_Toman'DATANHEC\export_HEC to_GIS\Bpot_H | =22 |

Terrain
Terrain Type  TIN { GRID
oo
Single Terrain  |[CM\BP_Toman \DATA\projekt\Vistvy'agreed  [2¢

® LiE DTM Tiles Layer =
Cutput Directory |C:"'-.E P_Toman‘DATA projelt Vizualizace Vizualizace_Q10 =
(Geodatabase Vizualizace_(3100
Rasterization Cell Size |1 (map units)

Ok | Help | Cancel |

Obrazek ¢. 22 — Okno nastroje Layer Setup s vyplnénymi parametry analyzy pro scénar o velikosti

kulminacniho pritoku Q1g9
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Po nastaveni zalozky Layer Setup ptisla na fadu zalozka HEC-GeoRAS ->
RAS Mapping -> Import RAS data, pomoci které byl nacten polygon mozného
rozsahu zaplavového izemi. Dale pak byly pouzity funkce ze zalozky HEC-GeoRAS
-> RAS Mapping -> Inundation Mapping. Jako prvni to byla funkce Water Surface
Generation, ktera vytvorila TIN kone¢ného zaplavového polygonu. Tato modelace
probiha protnutim TINu vodniho povrchu a DMT, kdy zaplavové uzemdi je stanoveno
jako uzemi, kde je vySka vodniho povrchu vétsi nez vyska DMT. Druha pouzita
funkce Floodplain Delineation Using Rasters, tato funkce vytvofi polygon

zaplavového tizemi pro feSeny scénar a rastr hloubek v tomto zéplavovém tzemi.

Obdobnym zptsobem byly analyzy provedeny i pro povodnové scénare

s dobou opakovani 20 a 50 let.

Vysledna vizualizace vytvotenych polygont a rastrit hloubek pro jednotlivé
scénafe byla nadtena na ortofotomapovy podklad z webovych stranek

www.geoportal.gov.cz, tyto vizualizace jsou soucasti priloh.

8.4 Porovnini vysledkii s vysledky VUV T. G. Masaryka

Srovnani polygonu zaplavového tzemi pro scénai o velikosti kulmina¢niho
pritoku Qigo Vytvofeny v této praci a polygonu pro stejny scénai vytvoreny VUV
T. G. Masaryka dostupnym na webovych strankdch www.dibavod.cz je viditelny na
obrazku ¢. 23. Zde je vidét ve stfedni a spodni ¢asti toku v nékterych usecich vetsi
a Vv n¢kterych mensi shoda ve vysledcich, avSak v horni ¢asti toku se vysledky
znaéné lisi. Mozné pficiny takovéto odliSnosti vysledkii budou podrobnéji rozebrany

v diskuzi.
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Obrazek ¢. 23 — Porovnani polygonii zaplavového vizemi vytvoreného v této praci (modry polygon) a polygonu
zaplavového vzemi vytvoreného VUV T. G. Masaryka (Srafovany polygon), podklad ortofotomapa dostupnd jako
WMS sluzba z webovych stranek http://geoportal.gov.cz/arcgis/services
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9. DISKUZE

Hlavnimi cily této prace bylo vymezit ¢ary zaplavového tizemi a vygenerovat
rastr hloubek v zaplavovém tzemi. Na webovych strankach www.dibavod.cz si Ize
stahnout hranice zaplavového uzemi, respektive Cary zaplavového tizemi pro celou
Ceskou republiku. Zpracovatelem téchto dat je VUV T. G. Masaryka, &ary
zaplavového tizemi jsou zpracovany jako polygony ve formatu shp, s timto formatem
je mozno pracovat v softwaru ArcGIS, vtomto programu jsem vizualizoval ¢ary
zéplavového uzemi, které byly vysledkem mé prace. Proto se nabizelo porovnat
vysledky této prace s vysledky VUV T. G. Masaryka, jako vyznamného odborného

pracovisté zabyvajiciho se vodohospodatskymi problémy.

Jako porovnavané zaplavové uzemi bylo vybrano inunda¢ni tizemi pro scénaf
o velikosti kulminaéniho pritoku Qigo. UZ pii prvnim pohledu je zietelné vidét, Ze
V horni ¢asti zajmového uzemi je Sitka polygonu vytvotfeného v této praci o mnoho
$irsi oproti polygonu vytvofenym VUV T. G. Masaryka. Pfi¢emz ve stiedni a spodni
¢asti zdjmového uzemi maji oba polygony vyrazné vétsi shodu, i kdyZz jsou

v nékterych mistech opét odchylky.

Otéazkou tedy je co se mohlo stat, Ze oba polygony pro stejné zaplavove
uzemi a pro stejny povodnovy scénaf nejsou totozné. Jednim z téchto divodi mize
byt krok, ktery jsem provedl z divodu malého rozsahu dat. Timto krokem bylo
pouziti funkce DEM Reconditioning v extenzi ArcHydro v prostiedi ArcGIS.
Pomoci této funkce jsem se pokusil ,,zahloubit* koryto toku do DMT vytvofeného
pravé kombinaci bodovych a liniovych dat, které jsem mél k dispozici. Problémem
ovSem bylo, ze liniova data jsem mél kdispozici pouze v zastavéném uzemi
a Vv extravilanu tyto data nebyla. To mélo za nasledek vytvoreni takového DMT, kde
bylo koryto toku pouze v intravilanu a v extravilanu chybélo. S takovym to DMT
nebylo mozno pracovat a proto byla pouzita funkce DEM Reconditioning, avSak zde
mohla nastat chyba. Koryto jsem totiz pro zjednoduseni ptedpokladal po celém
useku toku stejné. Je ovSem jasné, Ze koryto toku ptirodniho charakteru je v kazdém
profilu proménlivé o to vice na useku dlouhém ptes 10 km. Navic funkce DEM
Reconditioning byla pouzita uz na prvni ¢asti toku konkrétné cca v prvnich ¢tyiech
pricnych profilech po sméru toku, tedy na zacatku modelu, kde byl rozdil
Vv polygonech zaplavového uzemi nejvétsi. Zde mohlo byt koryto silné

poddimenzovano a to mohlo zapfiCinit evidované vyliti vody z koryta hned na
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zacatku uzemi a zapfiCinit zna¢né chyby v rozlivu vody v feSeném inunda¢nim
uzemi. Tim mohlavzniknout tak velka odchylka mezi vysledky této prace a prace

VUV T. G. Masaryka.

Dalsi mozna chyba Vv hydrodynamickém modelu mohla nastat, tak ze
Manningiv koeficient drsnosti byl po celém toku stanoven jako konstantni hodnota
0,33. Tato hodnota odpovida ptirodnimu korytu, ovSem na toku byly i casti, které
byly i stavebné, opevnéné ty se ovSem kvuli zjednoduSeni zanedbaly. Kdyby nebyly
To by mélo za nasledek zvySeni rychlosti toku v téchto usecich a tim i snizeni

kulminac¢niho pritoku a mozné zmenseni zéplavovych ploch v okoli téchto mist.

Kdyz jsem se ovSem zaméfil nejen na velikost odchylek sledovanych
polygonu, ale i na to v jakém tzemi byly tyto odchylky, zjistil jsem, ze tyto nejvetsi
odchylky a zaroven i jejich nejvétsi pocet byl jednoznaéné v inravilanu. To muze
ukazovat i na to, ze v téchto uzemich mohla byt podcenéna hustota pii¢nych profild.
Pti¢né profily byly totizZ po celém tzemi stanoveny po 100 m. Kdyby ovSem byly
v intravilanu vytvofeny napf. po 50 nebo 20 m, mohlo byt za pomoci vétsiho poctu
profilti dosazeno vétsi piesnosti tvaru a charakteru koryta v téchto usecich a mohlo to

mit za nasledek mensi plochy polygont zaplavovych Gizemi v intravilanu.

Je jasné, Ze vSechna tato fakta, kterd jsem popsal, mohla méné ¢i vice ovlivnit
vysledny rozsah zaplavového uzemi. Je také mozné, ze chyby vzniklé nékterou
z téchto udalosti by byly tak malé, Ze by vysledek neovlivnili, nebo by ho ovlivnili

pouze v kombinaci s jinymi chybami.

Ovsem podle mého nazoru vySel rozdil mezi obéma polygony zaplavového
uzemi s nejveétsi pravdépodobnosti hlavné kvili $patnému DMT, ktery dostatecné
dobfe nevystihoval charakter a Clenitost terénu (jako jsou tfeba lokalni naspy,
vyvySeniny atp.). V tomto ndzoru meé utvrzuje 1 fakt, ze nejvetsi odchylky od
polygonu vytvofenym VUV T. G. Masaryka byly v uzemi, kde byl realny terén
nejvice rozmanity. Tato chyba vznikla podle mé nasledkem malé podrobnosti
respektive hustoté¢ dat, které¢ jsem mél k dispozici. To potvrzuje i skutecnost, ze
vySkové body, které jsem ziskal a z kterych byl vytvofen DMT, byly od sebe
vzdaleny 30 m, ovSem nebylo vyjimkou, ze n¢které body méli mezi sebou 1 vétsi

rozestupy.
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10. ZAVER

Tato prace mela jako hlavni cil stanoveni zaplavovych car a rastru hloubek
VvV zaplavovém uzemi. Oba tyto hlavni cile byly splnény pro povodinové scénaie
s dobou opakovani 20, 50 a 100 let. Podrobnéji vizualizovany v pfilohach byl ovsem

jen scénai' s dobou opakovani 100 let.

Pro to, abych mohl dosahnout hlavnich cild, bylo zapotiebi splnit i dil¢i cile
jako bylo vytvoteni DMT, stanoveni hydrologickych charakteristik toku v zajmovém
uzemi, ale také pochopit danou problematiku. To si dovoluji tvrdit, Ze bylo také

splnéno.

Tato prace potvrdila, Ze je problematika modelovani povodnovych udalosti
dilezitym tématem. Jako podklad o tomto tvrzeni muze byt fakt, Ze i kdyz polygon
zaplavového tizemi stanovené v této praci pro jednotlivé scénate Gplné neodpovida
polygonu zaplavového tzemi zpracovanému VUV T. G. Masaryka, tak na zakladg
obou téchto polygonovych vrstev lze jednoznac¢né fici, ze pti vyskytu povodnové

udélosti v feSeném Uzemi dojte k ohroZeni majetku.

Jesté bych chtél zdaraznit, Ze pouzité vystupy nemohou byt pouZity jako
podkladni mapy pfii feSeni povodiiového nebezpeci. Jednim z téchto davodi je i to,
ze pi1 vypoctu hydrodynamického modelu nebyly uvazovany stavebni objekty na
vodnich tocich (mosty, lavky, jezy, propustky, atd.), které mohou ovliviiovat pribch
povodinové viny a v nékterych mistech vyrazné vzdouvat hladinu vodniho toku

Klabavy.

Zavérem bych chtél konstatovat, Ze prace mi ukdzala zakladni principy
feSeni této problematiky a na zakladé znalosti ziskanych v této praci bych chtél tyto
znalosti rozsifit vypracovanim nového hydrodynamického modelu na kvalitngjSich
vyskopisnych datech a rozsitit model o jiz zminované objekty na toku a popiipadé se

pokusil navrhnut 1 néjaké protipovodiiové opatieni, to vSe ale aZ v dalsi ¢asti studia.
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Ptiloha ¢. 1 — Kopie eviden¢niho listu hlasného profilu z monitorovaci stanice

Hradek u Rokycan

Evidenc¢ni list hlasného profilu ¢.189

Stanice kategorie : A

Nula vodoétu :

397,17 [m.n.m.] B

Tok : Klabava Stanice : Hradek

Kraj : Plzensky kraj ORP: Rokycany Obec : Hradek
Provozovatel stanice : CHMU Pizen

Centrum automatického sbéru dat :

Staniceni : 26.14 [km] Cislo hydrologického poradi : 1-11-01-020

Plocha povodi : 158,45 [km2] Zemépisné souradnice : 133944 v.d. 494251 s.8.

Procento plochy povodi toku : 45,0

Stupné povodriové aktivity : [em] [m3.s-1] Platnost SPA pro Usek toku :

bdélost 90 11,3 Hradek - VD Klabava

pohotovost 120 19,1 Kritické misto :

ohrozeni 150 28,0 Kamenny Ujezd, Rokycany
Pramémy roéni stav : 22 [cm] N-leté pratoky : Q1 Q5 Q10 Q50
Prdmeémy roéni pritok : 1,14  [m3s-1] [m3s-1] 16,5 42,7 58,3 104
Odesilatel zprav : Cetnost hlageni SPA : I 1 x denné
MeU Hradek II.  4xdenné

lll.  3hodinové hlaseni

Odesilatel poda zpravu :
Me&U Rokycany

OU Kamenny Ujezd

Spojeni na adresata :
371709547, 737718520, 737901406

Prijemce dale vyrozumi :
KrU Pizefiského kraje

OPIS HZS Rokycany, Magistrat mésta Plzné

Nejvy$si zaznamenané vodni stavy :

feml  V.-XL feml]
300 12.08.2002 133
243 28.05.2006 102

200 08.08.2002
131 03.06.2010

Popis umisténi profilu :
lavka pod koupalistém, levy breh

Mapa v méfitku 1:50 000 :

Xl - IV.
13.02.2005
18.04.2009

189 [ AKTUALIZACE : zari 2011]

©Cesky hydrometeorologicky ustav, Hlasna a pfedpovédni povodiiova sluZba.
Aplikace byla vyrobena firmou Hydrosoft Veleslavin s.r.o

Zdroj: www.chmu.cz
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Ptiloha ¢. 2 — Kopie eviden¢niho listu operativniho profilu z monitorovaci stanice

StraSice

Nejuyssi zaznamenané vodni stavy

femj V. - XTI lem]

Popis umisténi profilu

XIT. - IV

Evidencni list operativniho profilu

L .
=
Tok: Klabava Stanice: Stragice
Kraj:  Plzensky kraj ORP: Rokycany Obec:  Stradice
Proveozovatel stanice: MéL Rokycany
Centrum automatickeho sberu dat: RPP CHMUO Plzed
Stanicani: Tkm] Cislo hydrologického pofadr: 1-11-01-010
Placha povodi: 73.24 [km?] Femépisné soufadnice: 134541 v.d. 404330 5.5,
MNulz vedodtu: Im.nm.] B Procento plochy povodr toku:
Stupné povodhiowve sktivity: femj  [mis]
sucho
bdélost a5 6.97
pohotovost 120 109
ohrofens 150 17.7
extrémni ohroZeni 246 55.9
Priimérny rocni stawv fem] N-lete priftoky Qy Qs Qu Qs Qo
Priimérmy’ roéni priftok [mis] [mis] 898 3.2 317 566 70.2

Mzpa v méritku 1:50 00D :

Mapa neni k dispozici.

Zdroj: www.chmu.cz
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Ptiloha ¢. 3 — Rozmisténi klimatickych jednotek v povodi Klabavy dle Quitta

Zdroj: http://www.ovocnarska-unie.cz/web/web-sispo/klimreg/mapa.html

.......... Hranice povodi
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Ptiloha ¢. 4 — Charakteristika klimatickych jednotek podle Quitta, které se vyskytuji

v povodi Klabavy
MIRNE TEPLA
MT7 MT10 MT11
LetD 10 - 30 20-30 30-40 30-40 40-50 | 40-50
HVO | 120-140] 120 - 140 | 140- 160 | 140 - 160 | 140 - 160 | 140 - 160
MD 140- 160 | 130-160 | 130- 140 | 110- 130 | 110 - 130 | 110 - 130
LD 50 - 60 40 - 50 40 - 50 40 - 50 30-40 | 30-40
°C | -3--4 -3--4 -4 --5 -2 --3 -2 --3 -2 - -3
°C IV 4-6 6-7 6-7 6-7 7-8 7-8
°C VIl 15 - 16 16 - 17 16 - 17 16 - 17 17 - 18 17 - 18
°C X 6-7 6-7 6-7 7-8 7-8 7-8
s*tmm | 120-130 | 110-120 | 100- 120 | 100 - 120 | 100 - 120 | 90 - 100
sVO | 500-600 | 350 -450 | 350 -450 | 400 - 450 | 400 - 450 | 350 - 400
sVZ | 350-400 | 250-300 | 250-300 | 250 - 300 | 200 - 250 | 200 - 250
sp 100-120 | 60-100 | 60 - 100 60 - 80 50-60 | 50-60
0>08 | 150-160 | 120-150 | 120-150 | 120-150 | 120 -150 | 120 -150
0<0,2 40 - 50 40 - 50 50 - 60 40 - 50 40-50 | 40-50
Zdroj: Quitt 1971
Legenda:
Letb ... Pocet letni dni
HvVO .. Pocet dni s teplotou alespont 10°C
MD Pocet mrazovych dni
Lb Pocet ledovych dni
°CL Primérna teplota v lednu
°CIV. Priimérnd teplota v dubnu
eccvile Lo Primérna teplota v Cervenci
°CX Priimérna teplota v fijnu
s$lmm ... Pocet dnti se srazkami alespont Imm
svO ... Srédzkovy uhrn ve vegetacnim obdobi
svZz .. Srazkovy thrn v zimnim obdobi
sp Pocet dnil se snéhovou pokryvkou
0>08 ... Pocet dni jasnych
0<02 ... Pocet dni zatazenych
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Ptiloha ¢. 5 — Zastoupeni typtd pud v povodi Klabavy dle Tomaska (2003)

Zdroj: Tomasek 2003

.......... Hranice povodi

—
@
«Q
@
S
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.......... Pseudogleje s hnédymi ptidami oglejenymi

.......... Hnédé pidy kyselé

.......... Hnédé pidy silné kyselé

.......... [limerizované pudy s illimerizovanymi ptidami

oglejenym

.......... Hnédé pidys podzoly na terasovych ulozeninach

.......... RaseliniStni pidy

.......... Hnédé pudy se surovymi ptidami
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Ptiloha ¢. 6 — Zastoupeni krajiného pokryvu dle Corine Land Cover

Legenda nejvice zastoupenych ploch krajiného pokryvu v povodi Klabavy:

L 1) e

Zdroj: www.geoportal.gov.cz

Hranice povodi

Jehli¢naté lesy

SmiSené lesy

Priimyslové a obchodni arealy

Nesouvisla méstska zastavba

Nezavlazovana orna ptida

Louky a pastviny

Vodni plochy
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Ptiloha ¢. 7 — Podélny profil s hladinou vody pro kulmina¢ni pratok Qigg
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Prilohy

Ptiloha ¢. 8 — Pficny profil se stanicenim 900 m a se zobrazenim plnéni profilu pro

povodiiové scénaie Q1, Q20, Qso, Q100

412 Legend
wsat
410
Ground
Levee
408
g Bank Sta
g
£ 408
=
z
i
404
402
400
o 100 200 300 400
Station (m}
412 Legend
WS Q20
410
Ground
Levee
408
E Bank Sta
5
£ 408
2
@
i
404
402
400
0 100 200 300 400
Station (m)
412 Legend
WS as0
410 —
Ground
Levee
408
E Bank Sta
5
i 406
=
&
[}
404
402
400 T T T il
0 100 200 300 400
Station (m})
412 Legend
WS Q100
410
Ground
Levee
408
g Bank Sta
5
5 406
2
ko]
i
404
402
400
0 100 200 300 400
Station (m)




Lukas Toman

Prilohy

Ptiloha €. 9 — Pti¢ny profil se stani¢enim 3600 m a se zobrazenim plnéni profilu pro

povodiiové scénaie Q1, Q20, Qso, Q100
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Ptiloha ¢. 10 — Zobrazeni stanovenych zaplavovych car na celém zdjmovém uzemi
pro scénai Qigo, podklad ortofotomapa dostupna jako WMS sluzba

z webovych stranek http://geoportal.gov.cz/arcgis/services

Legenda

% zaplavové ¢ary pro Q100
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Ptiloha ¢. 11 — Zobrazeni stanovenych zaplavovych €ar na spodni ¢asti uzemi pro
scénaf Qioo, podklad ortofotomapa dostupnd jako WMS sluzba

z webovych stranek http://geoportal.gov.cz/arcgis/services

Stanoveni zaplavovych ¢ar pro scénar Q100

Legenda

% zaplavové ¢ary pro Q100

0 o
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Ptiloha ¢. 12 — Zobrazeni stanovenych zaplavovych Car na stfedni ¢asti uzemi pro
scénai Qipo, podklad ortofotomapa dostupnd jako WMS sluzba

z webovych stranek http://geoportal.gov.cz/arcgis/services

Stanoveni zaplavovych ¢ar pro scénar Q100

Legenda

% zaplavové cary pro Q100
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Ptiloha ¢. 13 — Zobrazeni stanovenych zaplavovych ¢ar na horni ¢asti tizemi pro
scénaf Qioo, podklad ortofotomapa dostupnd jako WMS sluzba

z webovych stranek http://geoportal.gov.cz/arcgis/services

Legenda

% zaplavové ¢ary pro Q100

73



Lukas Toman Prilohy

Ptiloha ¢. 14 — Zobrazeni rastru hloubek v inunda¢nim tzemi pro scénaf Qigo
podklad ortofotomapa dostupna jako WMS sluzba z webovych stranek

http://geoportal.gov.cz/arcgis/services

Rastr hloubek pro scénar Q100

Legenda

rastr hloubek pro Q100
Value

High : 6.56 m
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Ptiloha ¢. 15 — Zobrazeni rastru hloubek ve spodni ¢asti inunda¢niho tizemi pro
scénaf Qioo, podklad ortofotomapa dostupnd jako WMS sluzba

z webovych stranek http://geoportal.gov.cz/arcgis/services

Rastr hloubek pro scénar Q100

Legenda

rastr hloubek pro Q100
Value

High : 6.56 m
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Ptiloha ¢. 16 — Zobrazeni rastru hloubek v horni ¢asti inunda¢niho uzemi pro scénéar
Q100, podklad ortofotomapa dostupnd jako WMS sluzba z webovych

stranek http://geoportal.gov.cz/arcgis/services

Rastr hloubek pro scénar Q100

Legenda

| 4 rastr hloubek pro Q100
Value

High:6.56 m
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Ptiloha €. 17 — Zobrazeni rastru hloubek v zastavéném uzemi obce Dobftiv pro scénar
Q100 ve vztahu ke KN, jako podklad katastralni mapa dostupna jako

WMS sluzba z webovych stranek http://services.cuzk.cz/iwms/wms.asp

rastr hloubek proQ100
3
l‘q

Val \

ue
High: .56 m k
Low:0m
— hranice parcel
° definicni body budov - KN \
%“L\ AT e e Y WO R
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